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Oracle Copyright 

Copyright © 1995, 2010, Oracle and/or its affiliates. All rights reserved.  

This software and related documentation are provided under a license agreement containing 
restrictions on use and disclosure and are protected by intellectual property laws. Except as 
expressly permitted in your license agreement or allowed by law, you may not use, copy, 
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or 
display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation 
of this software, unless required by law for interoperability, is prohibited. 

The information contained herein is subject to change without notice and is not warranted to be 
error-free. If you find any errors, please report them to us in writing. 

If this software or related documentation is delivered to the U.S. Government or anyone licensing it 
on behalf of the U.S. Government, the following notice is applicable: 

U.S. GOVERNMENT RIGHTS 
Programs, software, databases, and related documentation and technical data delivered to U.S. 
Government customers are "commercial computer software" or "commercial technical data" 
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental 
regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject 
to the restrictions and license terms set forth in the applicable Government contract, and, to the 
extent applicable by the terms of the Government contract, the additional rights set forth in FAR 
52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500 
Oracle Parkway, Redwood City, CA 94065. 

This software is developed for general use in a variety of information management applications. It is 
not developed or intended for use in any inherently dangerous applications, including applications 
which may create a risk of personal injury. If you use this software in dangerous applications, then 
you shall be responsible to take all appropriate fail-safe, backup, redundancy and other measures 
to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any liability for 
any damages caused by use of this software in dangerous applications. 

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be 
trademarks of their respective owners. 

This software and documentation may provide access to or information on content, products and 
services from third parties. Oracle Corporation and its affiliates are not responsible for and 
expressly disclaim all warranties of any kind with respect to third party content, products and 
services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages 
incurred due to your access to or use of third party content, products or services. 
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Preface 
The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 

Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the 
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web 
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available 
on your network from which you can access the Agile PLM documentation (PDF) files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > 
Manuals in both Agile Web Client and Agile JavaClient. If you need additional assistance or 
information, please contact My Oracle Support (https://support.oracle.com) for assistance. 

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 

Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html 

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  

 

 
 

http://www.oracle.com/technology/documentation/agile.html
http://www.adobe.com/
http://www.oracle.com/technology/documentation/agile.html
https://support.oracle.com/
http://www.oracle.com/technology/documentation/agile.html
http://www.oracle.com/education/chooser/selectcountry_new.html
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Chapter 1 

What's New 
This chapter includes the following: 

 Metalink Disclaimer .............................................................................................................................................. 1 
 Install and Test Notice ......................................................................................................................................... 1 
 Oracle E-Delivery Download Checklist ................................................................................................................ 1 
 User Interface ...................................................................................................................................................... 3 
 Product Portfolio Management ............................................................................................................................ 4 
 Integration ............................................................................................................................................................ 4 

This section lists new features available in this release. 
 
 

Metalink Disclaimer 

The documentation of Agile PLM 9.3.x – including guides about Installation, Administration and 
Configuration, and the PLM Solutions – is no longer accessed through Metalink. Please use the My 
Oracle Support web site to access your Agile PLM documentation: 

https://support.oracle.com 

Install and Test Notice 

Important Install and test this release on a designated development server before installing it on 
your production environment. Your development environment should mirror your 
production environment as closely as possible to provide accurate testing results. It is 
important to validate the installation of this release, and confirm your integrations are 
working correctly as part of your minimum due diligence. Any problems or questions 
noted during your development system testing should be resolved before installing this 
release on your production environment. 

 

Oracle E-Delivery Download Checklist 

Oracle products are distributed as "E-Packs". An E-Pack is an electronic version of the software. 
Refer to the Media Pack description or the list of products that you purchased on your Oracle 
Ordering Document. Then, view the Quick Install Guide License List to help you decide which 
Product Pack you need to select in order to search for the appropriate E-Pack(s) to download. Prior 
to downloading, verify that the product you are looking for is in the License and Options section of 
the E-Pack README. Oracle recommends that you print the README for reference. 

https://support.oracle.com/
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Please download each Product Pack from the Oracle E-Delivery web site 
(http://edelivery.oracle.com/) as specified below. 

1. Oracle Agile PLM Application Components 

2. Oracle Application Server     

3. Oracle Database     

There will be an itemized part list within each of the packs and you will need to download all items in 
order to have the complete download for the desired Oracle Agile release. 

All Oracle E-Delivery files have been archived using Info-ZIP's highly portable Zip utility. After 
downloading one or more of the archives, you will need the UnZip utility (for UNIX or Windows 
platforms) or the WinZip utility (for Windows platform) to extract the files. You must unzip the 
archive on the platform for which it was intended. Verify that the file size of your downloaded file 
matches the file size displayed on E-Delivery. Unzip each Zip file to its own temporary directory. 

For example, create a directory structure called oraAS10g on your hard drive: 

c:\oraAS10g 

Then create a new directory for each Zip file you downloaded: 

c:\oraAS10g\Disk1 

c:\oraAS10g\Disk2 

After extracting the software from the Zip files, you can install from your computer's hard drive. 
 

Important Please view the Quick Install Guide to ensure that the correct comprehensive Oracle 
"E-Packs" have been downloaded that correspond to your customer licenses for this 
Oracle release. 

 

Oracle Agile Product Overview Checklist 

After reading the content of this Oracle Agile PLM release document, we suggest performing the 
following tasks: 

 Feature Review: 
 Review the New Features and Resolved Issues sections to make sure you understand the 

overall product changes in this release. 

 Business Process Review: 
 After completing the New Feature and Resolved Issues review, make sure you understand 

if any of your current business processes are impacted by this release and/or if they might 
need to be modified and re-evaluated.  This is a very important preparation step as you 
move forward with implementing any Agile release. Make sure all of your key business 
processes are thoroughly documented and you have an overall business owner who 
understands each process. Use this list of processes as a checklist against the features 
and changes in this Agile release. You may want to assign a “weight” to each change in 
terms of how significant an impact it has to your organization (think about re-training users, 
changing current integrations, etc.) 

http://edelivery.oracle.com/
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 Identify resources to install and test this release. 
 Make sure that a test environment is ready and that tests have been developed to ensure 

this release performs the functions necessary for your business. Verify that the system can 
be rolled back in the unlikely event of a failure. Make sure that your testing includes all 
aspects of the product features, all of your business processes and any integration that 
you may have (AIS, SDK, ChangeCAST, ACS, etc.). If considering switching to LDAP 
authentication, come up with a plan to test the LDAP integration. Make sure to cover 
common scenarios like changing password, removing a user, etc. 

 Create an upgrade plan and strategy. 
 For a release, we recommend engaging our Oracle Consulting Organization for your 

upgrade. Validate the hardware configuration according to the Capacity Planning Guide. If 
you plan to manage your own upgrade, create a very detailed upgrade plan that includes a 
scheduled start time, an established number of “dry” runs, a pre-determined rollout date, 
and a designated team of individuals across your organization with detailed knowledge of 
product, technology, networking, business process, etc. 

 Prepare end-user training. 
 We recommend exposing a number of your power users to the new version well in 

advance of a production rollout to ensure that your users deeply understand the product 
functionality. Much of the end user training will actually begin during the testing phase. Use 
this feedback as a basis for your overall end-user training. 

 

User Interface 

The User Interface of Oracle Agile PLM Web Client was significantly improved in Release 9.3 – 
including new input controls, components and productivity features to help users efficiently and 
accurately complete their tasks. If you have upgraded from PLM 9.2.x to PLM 9.3.x, please refer to 
Getting Started with Agile PLM manual. The user guide for each PLM solution also documents Web 
Client's enhanced UI. 

Searches 

The new features below apply to Searches in all PLM solutions. Items 3 and 4 apply particularly to 
the Product Portfolio Management solution. 

1. If there are more than 200 user groups in the system, the dropdown list for users has, besides 
Users and User Groups, a new option called "Search within a User Group". The dropdown list 
no longer displays all the user groups individually. 

2. If the "Search within a User Group" option is selected, and then a user group is selected to 
search for users in that user group, that user group is added to the dropdown list as a "recently 
used" user group. The maximum number of user groups is 20: as user groups are added to the 
dropdown list (by using the "Search within a User Group" option), beyond 20 UGs the system 
removes the first-added entry from the list. 

3. On PPM objects, on the Team tab, in Add and Substitute dialogs, those user groups already 
added to the Team table are filtered out of the recently visited user groups list on the dropdown 
list as well as from the "Search within a User Group" search. 

4. The "Search within a User Group" option searches for all user groups (Personal, Global, 
Resource Pool, or non-Resource Pool); when adding a user, if the user belongs to a Global 
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user group or a Resource Pool, the Assigned From field on the table is populated; when adding 
a user from a Personal group or non-Resource Pool group, it is treated as assigning the user 
directly and the Assigned From field is not populated. 

 
 

Product Portfolio Management 

Please see the items under "Searches", above. 

Integration 

SDK 

1. Added support in SDK for Relationship and Content searches. 
 For CTO content search, use 

QueryConstants.TRANSFER_ORDER_SELECTED_CONTENT 
 For relationships on all objects and content search in PPM, use 

QueryConstants.RELATIONSHIPS  

Refer to SDK Guide for further information. 

2. A new interface called IRedlinedTable is added and all redline tables implements this. There 
are two APIs in IRedlinedTable for bulk undoRedline: 
 public void undoRedline(Collection c); 
 public void undoAllRedline(); 
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Chapter 2 

Resolved Issues 
This chapter includes the following: 

 Install and Test Notice ......................................................................................................................................... 5 
 Service Pack Hot Fix Note ................................................................................................................................... 5 
 Install and Upgrade .............................................................................................................................................. 6 
 Administration ...................................................................................................................................................... 8 
 Integration ............................................................................................................................................................ 12 
 Common Services ............................................................................................................................................... 20 
 Product Collaboration .......................................................................................................................................... 35 
 Product Cost Management .................................................................................................................................. 45 
 Product Governance and Compliance ................................................................................................................. 47 
 Product Portfolio Management ............................................................................................................................ 47 
 Product Quality Management .............................................................................................................................. 50 
 AutoVue for Agile ................................................................................................................................................. 52 

This section lists issues that were resolved during this release. Numbers in bold (for example, 
123456) are Customer Support ID numbers from customer-reported issues. 

Install and Test Notice 

Important Install and test this release on a designated development server before installing it on 
your production environment. Your development environment should mirror your 
production environment as closely as possible to provide accurate testing results. It is 
important to validate the installation of this release, and confirm your integrations are 
working correctly as part of your minimum due diligence. Any problems or questions 
noted during your development system testing should be resolved before installing this 
release on your production environment. 

 

Service Pack Hot Fix Note 

Note The contents of this release include the following Patches (HotFixes):  
Oracle Agile PLM Release 9.2.2 HotFix 12; 
Rel. 9.2.2.1 HotFixes 14, 30, 34–40, 42; 
Rel. 9.2.2.2 HotFixes 4, 40, 41; 
Rel. 9.2.2.3 HotFixes 25–29, 31, 32, 34–50; 
Rel. 9.2.2.4 HotFixes 21–23, 25–39, 41–43, 45–54, 58; 
Rel. 9.2.2.5 HotFixes 4–6, 8–10, 12, 14, 15, 17, 19, 21–33, 35–44; 
Rel. 9.2.2.6 HotFixes 1–6, 8–17, 20, 22; 
Rel. 9.3 (9.3.0.0) HotFixes 1–6, 8, 14. 
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Install and Upgrade 

Automated Upgrade Tool (AUT) 

7539223 

7239401.992 

DB Upgrade/AUT 

Issue: PSR objects on Preliminary Items do not display Affected Items (AI) tab contents after 
upgrade. 

Root Cause: Bug in Upgrade script. 

Resolution: Add the following Script to postupgrade90.sql: 

Update psr_item set rev_found_id=0 where rev_found_id is null; 

Verification Steps: 

1. Checked the problematic PSRs reported in the issue. 

2. Now we see the AI items tab objects without any problem. 

3. Checked for the added SQL statement in the post85to90 script. 

4. Connected the upgraded DB to the 9.2.2.4 Application Server and was able to log in to both 
clients successfully. 

8440077  and  8440118 

21095206.6  and  21095206.6 

DB Upgrade/AUT 

Issue: When attempting to view the default logs the following error occurs: 

(8440077)  ORA-00001: UNIQUE CONSTRAINT (TEST1_AD.NOTIUSER_PK) VIOLATED  

(8440118)   FAILED TO CREATE NOTIFICATION - ORA-00001: UNIQUE CONSTRAINT 
(AGILE.NOTIF_FIELDS) VIOLATED 

Root Cause: The cause occurs when upgrading to 9225, AUT's code or script doesn't reset the 
sequence 'NOTIFICATION_USER_SEQ' and 'NOTIFICATION_SEQ' to proper start value, which 
leads to unique constraint violation later. The value of the two columns seems to be the same, but 
actually they are generated from different sequences ('NOTIFICATION_USER_SEQ' and 
'NOTIFICATION_SEQ' respectively ), so they do not have same value. 

Resolution: Two new AVerify test cases have been added (in the AVerify tool as well as in AUT) to 
catch these type of sequences error. 

Verification Steps:  

1. Upgraded the same db to 9.3.0.1 using AUT1.6.2 
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2. Connected the upgraded DB to Application Server and there are no server start-up errors related 
to the issue reported. 

3. Server started cleanly without any errors. 

8531067 

7499920.993 

DB Upgrade/AUT 

Issue: Invalid objects in Agile schema after upgrade. 

Root Cause: The objects GMT_CONVERT, STR_GMT_CONVERT, GETFILESFLAGS, 
AGILE_MIGRATE_FULLNAME, and CONVERT_TO_STR_GM  were created in 85to90 upgrade script 
but they were not dropped. 

Resolution: Now the DROP statement has been added in post85to90sp1 upgrade script for these 
objects. 

Verification Steps: The check_index procedures are present in AVerify, and the drop statement has 
been added for these objects. Upgraded 85sp4 db to 9.3.0.1 using AUT and after upgrade checked 
for the invalid objects in the db using SQL: select object_name, status, object_type from all_objects 
where status = 'VALID' and owner = '<username>' ; It has not returned any of the objects reported 
in the bug as invalid. 

9073710 

2-5979765     7771762.994 

DB Upgrade/AUT 

Issue: Agile-Advantage–to–Agile-9.3 upgrade issue does not contain operator 

Root Cause: During 9.3 UI development, the 'Does not Contain' operator is changed to 'Contains 
None' and 'Contains' operator is changed to 'Contains All' for List-type attributes. But this change 
was not included in the Upgrade script for AUT. Because of this, while upgrading customer 
database, the criteria that use these operators did not migrate properly. 

Resolution: Added the upgrade script which updates all criteria that use these operators into new 
operator. 

Verification Steps: 

1. Upgraded NOAA db to 9.3.0.1 using AUT1.6.2. 

2. After upgrade, connected the 9301 DB to application server and logged in to the application as 
administrator. 

3. Checked for the specified criteria in the issue: 

(DP Global) Discover - Read Changes 

(DP Global) Discover - Read Items 

For these, now the criteria is pointed to 'Contains None', which is supported in 9.3. 
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9082399 

2-6005091 

DB Upgrade/AUT 

Issue: Null pointer exception on moving the Stop Ships workflow to next status 

Resolution: Delete adminmsatt where attid in (218,219,257) and value = '–1'; commit; 

Verification Steps: 

1. Upgraded database to 9.3.0.1 using AUT1.6.2. 

2. After upgrade, connected the DB to 9.3.0.1 Application Server and logged in to Web Client and 
Java Client. 

3. Create a Stop Ships change in Web Client. 

4. Assign a Stop Ships workflow to the change created. 

5. Should be able to change the status to Review.  

 
 

AVerify 

8320726 

7383353.993 

DB Schema Verify 

Issue: AVerify takes 7–8 hours to run and hangs on Agile Testcases  AGIL-00025047 and AGIL-
00025048. 

Root Cause: The testcases contained an error. 

Resolution: Testcases have been tuned, as follows: insert into error_report (error_id, error_type, 
table_name, id, reason). Select 'AGIL-0025047', 'E', 'USER_GROUP', id, 'Missing dummy row in 
page_two table.' from user_group where id not in (select id from page_two where class=11885); 

  Insert into error_report (error_id, error_type, table_name, id, reason). Select 'AGIL-00025048', 'E', 
'USER_GROUP', id, 'Missing dummy row in page_three table.' from user_group where id not in 
(select id from page_three where class=11885). 

Verification Steps: The testcases AGIL-0025047 and AGIL-0025048 have been tuned as the 
resolution provided above. Ran the reported testcases on the DB and it took less than 15 minutes to 
execute. 
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Administration 

8417596 

7091418.993 

Administration/Configuration 

Issue: Display type of List such as Change Analysts list and Component Engineers is changed from 
As AddressBook to As Dropdown List unexpectedly. 

Root Cause: The update of the Display column on the ListName table is occurring without a WHERE 
clause. As a result, all rows in the ListName table are being updated. 

Resolution: The SQL for updating the Display column for a list has been changed to make sure only 
the list being changed is updated. 

Verification Steps: 

1. Log in to Java Client as administrator. 

2. Set user's langugage preference to Japanese. 

3. Log in again to JavaClient as administrator. 

4. Go to Admin tab > Data Settings > Lists. 

5. Set Display Type of Change Analysts list and Component Engineers list to As AddressBook. 

6. Go to Admin tab > Data Settings > Classes. 

7. Select any user-defined Part subclass, and set Enabled = No. 

8. Log out from Java Client. 

9. Restart the Application Server. 

10. Log in to Java Client. 

11. Go to Admin tab > Data Settings > Lists 

12. Notice that Display Type of Change Analysts list and Component Engineers list are re-set to As 
Drop-down list. 
 

8557918 

7502400.993 

Notifications and Subscriptions 

Issue: Some system-generated notification emails (listed in "Root Cause") contain an incorrect word, 
your instead of you. 

Root Cause: In the following notifications… 
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1. Designs: Review Design, Add Observer (Body and Subject) 

2. File Folders: Review File Folders, Add Observer (Body and Subject) 

3. Problem Reports: Approve Problem Report, Add Observer (Body) 

… the phrase "has been routed to your for your information only" should be "has been routed to you 
for your information only". 

Resolution: The notification templates have been updated with the correct grammar. 

Verification Steps:  

1. Log in to Java Client as an administrator. 

2. Go to System Settings > Notifications. 

3. Select one of the Notification templates with the reported issue: 

     - Designs: Review Design, Add Observer  

     - File Folders: Review File Folders, Add Observer  

     - Problem Reports: Approve Problem Report, Add Observer  

4. Manually verify that the text has been corrected. 

5. If text is not correct, then correct the text. 
 

8602015 

7551034.993 

Administration/Configuration 

Issue: Advanced Search does not return the parts that exists in the database when use Cascading 
List as the Search criteria. (Advanced Search returns no record for List value in Cascading List.) 

Root Cause: The cache behaves differently between startup and normal activity during the day. As a 
result, it is important that no child list is equivalent to an empty child list. 

Resolution: Empty child lists are now treated the same as if there were no child list at all. 

Verification Steps:  

1. Log in to Java Client as administrator. 

2. Create a new cascading list named 'Casc_List1' with a 4-level structure, as below: 

Level 1-1  -->  Level 2-1  -->  Level 3-1 

Level 1-2  -->  Level 2-2  -->  Level 3-2 

Level 1-3  -->  Level 2-3  -->  Level 3-3 

Level 1-4  -->  Level 2-4  -->  Level 3-4 

3. Save it. 
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4. Open it and drop third-level list 'Level 3-4' from parent list 'Level 2-4' 

5. Save it. 

6. Add this cascading list to Part subclass for Page Three > List01 and name List01 as 
'Cascading_List1' 

7. Create two new parts 'PN-T0002' & 'PN-T0003' with this cascading list and assgin value as 'Level 
2-4' for Page Three Cascading_List 1. 

8. Create a new Advanced Search to search these two new parts with criteria as below: 

Part > Page Three.Cascading_List1 in Level 2-4 

9. Click Search button. PN-T0002 & PN-T0003 can be searched and corrected. 

10. Click Format Table, add Page Three.Cascading_List1 into displayed table, and click Apply. 

11. The Cascading_List1 values are displayed corrected in the search results. 
 

8926623 

2-5908702    7752380.992 

Administration/Configuration 

Issue: Agile list values no longer sorted in alphabetical order in Java Client. 

Root Cause: The fix for performance bug #8261830 introduced this issue. In that fix, a threshold for 
sorting was introduced. To preserve the old APIs, the default threshold was set to –1 rather than a 
large positive number. The assumption is that –1 was intended to indicate that sorting should 
always take place. 

Resolution: Changed the default threshold to 2147483647. This is the maximum value for an integer. 

Verification Steps: 

1. Login to Agile Java Client. 

2. Create new Part. 

3. Click autonumber , Select Part Number. 

4. Click dropdown on Parts.P2.Buyer: ZebraTest. 

5. Check List values are sorted correctly, click OK. 

6. Click on dropdown arrow of Parts.TB.Size field. 

7. Check List values are sorted correctly. 

Expected Results: 

(4.) Buyer List Values should be sorted correctly on Parts.P2 

(6.) Size List Values should be sorted correctly on Parts.TB (Title Block) 
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9078911 

2-5980401    7770764.993 

Administration/Configuration 

Issue: PLM 9.3 broke the privilege that allows users to make their user groups global. 

Root Cause: Handle Administrator privilege for this attribute, actually, we just need to check Modify 
privilege for this attribute (Global/Person). 

Resolution: comments check admin privilege code, and remain check modify privilege. 

Verification Steps: 

1. Create a user, assign a role that contains Read and Modify user group.GI.Global/Personal field's 
privileges to it. 

2. Log in to Web Client or Java Client. 

3. Create a user group, make sure can modify the Global/Personal field in General Info tab. 
 

Integration 

SDK 

7077651 

18952862.6 

SDK 

Issue: Not able to search Transfer Order (ATO, CTO) for content data using SDK. Advanced Search 
feature in Web Client and Java Client allows search in Transfer Orders but this functionality is not 
achievable using SDK. 

Root Cause: Agile SDK does not permit Relationship and content searches. 

Resolution: Added support in SDK for Relationship and Content search: Content search now works 
on CTOs, and Relationship search now works on all PLM objects. Set query.SetSearchType as 
below: 

For CTO content search, use QueryConstants.TRANSFER_ORDER_SELECTED_CONTENT. 

For relationship on all object and content search on PPM, use QueryConstants.RELATIONSHIPS. 

And set query.setRelatedContentClass with the class ID (class ID or subclass ID) (ID or Name or 
API Name). 

Verification Steps: Perform these steps through SDK. 

CTO Content Search: 

1. Create part 'P1' and set desc as 'SDK test'. 
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2. Create 3 CTOs. 

3. Add P1 to Selected Content tab of all CTOs. 

4. Query as shown below: 
IQuery query = (IQuery)m_session.createObject(IQuery.OBJECT_TYPE, 
TransferOrderConstants.CLASS_CTO); 

query.setSearchType(QueryConstants.TRANSFER_ORDER_SELECTED_CONTENT); 

query.setRelatedContentClass("Part"); 

query.setCriteria("[Selected Content.Part.Title Block.Description] == 
'SDK test'"); 

5. The 3 CTOs are retrieved successfully. 

 

Relationship Search: 

1. Create part 'P1' and set desc as 'SDK test'. 

2. Create 3 ECOs. 

3. Add P1 as relationship to all ECOs. 

4. Query as shown below: 
IQuery query = (IQuery)m_session.createObject(IQuery.OBJECT_TYPE, 
ChangeConstants.CLASS_ECO); 
query.setSearchType(QueryConstants.RELATIONSHIPS); 
query.setRelatedContentClass("Part"); 
query.setCriteria("[Relationships.Part.Title Block.Description] == 
'SDK test'"); 

5. The 3 ECOs are retrieved successfully. 

7095931 

18998160.6 

SDK 

Issue: Request for batch API for "Undo Redline". 

Root Cause: Redline table doesn't support bulk Undo Redline. 

Resolution: A new interface called IRedlinedTable is added and all Redline tables implement this. 
There are two APIs in IRedlinedTable for bulk undoRedline as below: 

public void undoRedline(Collection c); 
public void undoAllRedline(); 

Verification Steps: Perform below through SDK: 

1. Create Assembly [Parent] with 5 BOM. 

2. Create and release ECO. 

3. Create a second ECO. 
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4. Redline modify all the rows and add 2 new BOMs. 

5. Undo redline of a couple of rows [e.g., rows 2 and 4] using: 
ITable tab_redline = 
parent.getTable(ItemConstants.TABLE_REDLINEBOM); 
List del = new ArrayList(); 
del.add(rows[2]); 
del.add(rows[4]); 
((IRedlinedTable)tab_redline).undoRedline(del); 

6. Redline modifications of rows 2 and 4 are removed. 

7. Undo redline of all the rows using: 
 ((IRedlinedTable)tab_redline).undoAllRedline(); 

8. Redline modifications of entire table is removed. 

7100544 

19007492.6 

Process Extension (PX) 

Issue: Internal custom action Process Extension is not available after deleting the Role that was 
assigned to it in production server. 

Root Cause: Reference handling to Administrator objects is inconsistent. There isn't a consistent way 
to ask the application if the Admin object is in use nor is there a consistent way to ask the 
Administrator configuration if the Admin node is use. 

Resolution: * To improve the error messages to provide where-used information when possible. 

* Provide a consistent look and feel to the error messages used. 

* Modified some of the existing in-use messages to state that the object is in use by the application. 

* Used an example strategy. To prevent the list of where-used objects from getting out-of-hand, the 
list is limited to 10 entries. If more than 10 entries are displayed, the number of "known" usages is 
provided in the message. This gives the user a sense to the magnitude of use for the object. 

Verification Steps:  

1. Log in to Java Client. 

2. Create a new Role. 

3. Create a new Process Extensions and add this new Role. 

4. Delete this new Role. 

5. Not able to delete the role and getting proper message as below: 
Object "<new role name>" is in use by the following object(s): 

Process Extension: <PX name created in step 3> 
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7101264 

19011222.6 

SDK 

Issue: Access resolution_code in from Agile SDK; customer cannot get in the list of methods in SDK, 
and specifically wants to access: Product Service Requests base class > Cover Page > 
PSR.RESOLUTION_CODE. 

Resolution: It was fixed on server side after 9221; Test case passed. QA will add testcases for this 
now to keep it checked going forward. 

Verification Steps: Perform these steps through SDK: 

1. Create PSR 'psr1'. 

2. Set the value of PSR.RESOLUTION_CODE as shown below: 
psr1.setValue(ServiceRequestConstants.ATT_COVER_PAGE_DISPOSITION,"Re
work to Spec"); 

3. Able to set resolution code value successfully. 

8441818 

7496562.992 

SDK 

Issue: Memory leak in Declaration > Manufacturer Parts > Substances table. 

Root Cause: SDK table holds strong reference to the Iterator used by the Client code. 

Resolution: Use weak reference to Iterator. 

Verification Steps:  

1. Create 10 Declarations and add 10 Manufacturers to each Declaration. 

2. Iterate through the Manufacturer table of each Declaration 500 times and update Description. 

3. Able to iterate and update Description without any error. 

8452691   and   8424866 

21113230.6     2-1995761     2-4110435    2-5267972    7427635.993  

SDK 

Issue: SDK program that is meant to create Cascading List throws exceptions. 

Root Cause: The background process "Admin Cache Sync" which is intended to bring the in-memory 
version of an object up to date with the database version of the object is also updating the in-
memory object with the database object when the database version is less than the in-memory 
version. 

Resolution: Changed the condition used to determine which objects need to be synchronized from 
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"in-memory version" != "database version" to "in-memory version" < "database version". 

Verification Steps: Just before the background task "Admin Cache Sync" starts (which is every 5 
minutes), do the following: Create a cascade list with many entries through SDK. Successfully 
created the list. 

8463712 

7410939.993 

SDK  

Issue: Unable to identify Redline changes on BOM rows using IRedlined Interface. 

Classcastexception on referencedesignatorcell when casting to iredlined. 

Root Cause: Reference Designator doesn't extend CellRedlined. 

Resolution: Change Reference Designator to extend CellRedlined. 

Verification Steps: Perform below through SDK 

1. Create Assembly [Parent] with BOM. 

2. Create and release ECO. 

3. Create a second ECO. 

4. Get the redline BOM row. 

5. Cast the reference designator cell to IRedlined. 

6. Able to cast reference designator cell to IRedlined. 

8845066 

2-5887745     7488374.992 

SDK 

Issue: When attempting to run an SDK application and query for all changes that  require a user's 
approval (Workflow.Approver), the following error occurs: 

  ERROR:  APIException (60093, Relational operator "equal to" can't be used with the attribute 
"Workflow.Approver".). 

Root Cause: SDK code always converts "contains" to "equal to". But Server doesn't support "equal 
to" for some of the attributes. 

Resolution: For safer fix for 9301, convert "contains" to "equal to" only if "equal to" is supported. If 
not, send "contains" operator itself. The correct solution would be to pass "contains" operator as 
"contains" and if not supported, pass it as"equal to". But this solution is risky and needs extensive 
testing and it may break customer code if they expect "equal to". 

Verification Steps:  

1. Create a query through Agile SDK as: 
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IQuery query = (IQuery) session.createObject(IQuery.OBJECT_TYPE, 
ChangeConstants.CLASS_ECO); 
String criteria = "([Workflow.Approver] contains ([" + 
UserConstants.ATT_GENERAL_INFO_USER_ID + "] == 'gregri'))"; 

query.setCriteria(criteria); 

2. Query executed without any errors. 
 

FileLoad 

8413389 

7464262.992 

FileLoad 

Issue: Fileload fails with [ora-00955]: name is already used by an existing object when running by 
multithreaded mode. 

Root Cause: purging involved creation of temporary table.the name for temporary table was not 
threadsafe.  

Resolution: A random number is appended to name of temporary table. 

Verification Steps: 

1. Log in to Java Client as admin 

2. Navigate to Admin|System Settings|Viewers & Files 

3. Make configuration as below and Save changes: 

    - Auto Purge Enabled = Yes 

    - File Version Keep = 0 

4. Create index file to load files. (File can be URL. Create about 10 lines) 

5. Log in to Java Client with user that have Fileload privilege 

6. Goto Tools > Fileload 

7. Set Index File 

8. Change "Number Of Dedicated Threads" to a number greater than 1. (1 to 100) 

9. Set Log File Directory and OK 

File is uploaded without any error message 
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Import 

8568885 

7525124.994     7775015.992 

Import  

Issue: Duplication of Site-specific Items while importing Items using Agile Import. 

Root Cause: Changes made in 9225 for bug 7101988. During executions of the 
addToAffectedItems() call, site info for both the common site and the additional site are created. But 
subsequent call to CMImportFactory.batchAddSiteByObjID, inserts the site info again. 

Resolution: Put the batchAddSiteByObjID() call prior to addToAffectedItems(). 

Verification Steps:  

1. Create a source file as: 
 Item Number: PQ01-011 
 Item Type: Part 
 Site: India 

2. Log in to Web Client. 

3. Click Tools > Import and add the above created file 

4. Now, import the file in redline mode by creating an ECO. 

5. After importing, navigate to the Part > Changes tab and Changes > Affected Items tab. 

Note: No duplicate entries are found and data is same as in the source file. 

9139535 (same as 8858316) 

3-1083444851 

Import 

Issue: Problem in importing discussion object on Programs. 

Root Cause: The code handled the discussion p3 attributes differently. The subclass ID was 
appended with attribute id and this was used as the integer key in propertyDescriptor map. For new 
subclasses the combination of subclassid and attribute was beyond the Integer maximum limit. 

Resolution: Add a level of indirection using a map. In 
DiscussionAssociationDescriptorGroup.loadPropertyDescriptors() method, 
instead of creating dummyAttrID using the subclass ID, we can use an index (starting with a value, 
1000). The index will be incremented for each subclass. 

Verification Steps: 

1. Log in to Web Client. 
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2. Create a program and add a discussion to it from collaboration tab. 

3. Export the program in excel format. 

4. In excel file include Program number and name for discussion header rows. 

5. Save the file. 

6. Now in application, select Import from tools menu. 

7. Browse for the above file and click on next. 

8. Select Project -> Discussion and click Next. 

9. Map the attributes and continue the import. 

Result: User is able to import the discussions. 
 

Agile Technology Platform 

8935014 

7772420.992      2-5992616 

Directory Access Protocol (LDAP) 

Issue: Error synchronizing 100000 users from LDAP to Agile. 

Root Cause:  The preferred portal URL of Agile users is not being used since Agile 9.3. 

Resolution: When creating a user, remove this information. 

Verification Steps: 

1. Configure Sun One Iplanet LDAP server which has 13000 users with Agile. 

2. Check the preview of the users in Java Client. 

3. Try to Migrate 13000 users to agile. 

4. Result: All 13000 Users are migrated successfully in to Agile. 

Comment: We don't have Sun One iPlanet LDAP server with 100000 users. We have Sun One 
Iplanet server with 13000 users. Verified with 13000 users migration from Sun One LDAP server to 
Agile. 

9051781 

2-5832881   7797587.992 

Directory Access Protocol (LDAP) 

Issue: Agile LDAP problem - not all users brought in and they are inactive. 

Root Cause: Program error that was introduced in 93 while fixing a infinite loop; 
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Resolution: Make sure to exit only if there are no more search results. 

Verification Steps: 

1. Configure application server with AD with group filter. 

2. Make sure that there are more than 1000 users in the search path. 

3. Do a command line or Java Client refreshing users from LDAP. 
 

Common Services 

8305119 

7304969.994 

Folders, Files, and Attachments 

Issue: Not able to upload uncompressed file from Web Client along with compressed files.  

Root Cause: The uncompressed files selected after a Zip file with "Unzip" option are not uploaded to 
File Vault while uploading files from Web Client without using File Productivity Preference. 

Resolution: Changed files: FileUploadHandler.java 

Verification Steps: 

1. Log in to Web Client. 

2. Create a business object. 

3. In Add File window, select one or more zip files with "unzip" option. 

4. Select uncompressed files. 

5. Upload files. 

6. After files have been uploaded: 

   a. Verify that the uncompressed file is in the vault. 

   b. Try to get the uncompressed file. 

   c. Try to view the file. 

7. All the actions are successful. 

8323528 

7381991.993 

Searches 

Issue: Manufacturer > Mfr.Country attribute value does not display on Search result. 
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Root Cause: The Parts.Mfr.MfrCountry attribute referred to the incorrect country attribute. 

Resolution: Database metadata issue; updated Parts.Manufacturer.MfrCountry attribute 1857 to refer 
to Mfr.CoverPage.Country attribute 1751. 

Verification Steps: 

1. Log in to Java Client as administrator. 

2. Set Manufacturer class > General Info > Country/Area attribute to Visible. 

3. Create a new list for this attribute (e.g., Test_List01), add some list values (e.g., U.S., Japan). 

4. Now set Parts class > Manufacturers.Mfr > Country/Area attribute to Visible. 

5. Log in to Web Client. 

6. Create Manufacturer (e.g., Maker1) and fill in General Info.Country/Area attribute list. 

7. Create Manufacturer Part (e.g., MP00005), and add Maker1 as manufacturer. 

8. Create Part (e.g., P00020) and add MP00005/Maker1 as AML. 

9. Run Advanced Serach with following search critieria: 

Items | Parts | Object Search | Title Block: start with "P000" 

10. Go to Format Table. 

11. Add Manufacturer.Mfr Country attribute to Displayed Fields. 

12. Run Search, check output result for P00020. Note that the value for Manufacturer.Mfr Country 
can be displayed correctly 

8364319   and   8760277 

7481741.992    7490053.994    7656629.992 

Searches 

Issue: (8364319) Incorrect results are returned when attachment Filename is used in the search 
query. When a Search Criteria includes Attachments.Filename "Is Not Null", the result did not return 
a part known to have attachments. But when the Search Criteria for the Attachment.Filename is set 
to "Is Null", the result returned the part that has attachments.  Also, (8760277) Search/Report 
results do not show attachment Filename. The customer reported that if last release for the Item is 
on the ECO, then the attachment name appears. If, however, the last release of the Item is on the 
MCO, then the attachment name does not appear. 

Root Cause: One of the join conditions used by search(when any attributes from attachment tab is 
used in search criteria/display)  is ATTACHMENT_FULL_MAP. PARENT_ID2 = 
ITEM_P2P3_QUERY.DEFAULT_CHANGE, where PARENT_ID2 is the change associated with the 
attachment and DEFAULT_CHANGE is the latest released change. 

PARENT_ID2 column in ATTACHMENT_MAP table is updated only when an ECO is released, not on 
ECR/MCO/SCO. DEFAULT_CHANGE column is updated when you release a Change 
(ECO/MCO/SCO). So when an MCO is released, the DEFAULT_CHANGE is updated with the MCO 
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ID, but PARENT_ID2 is not updated, so the search does not return any records. 

Resolution: Add new column latest_released_eco in item table to only store latest released ECO. 

Verification Steps: (8760277) 

1. Log in to Agile, create a part (e.g., Part1) and add one attachment (e.g., 1.txt). 

2. Create an MCO for Part1. 

3. Release the MCO. 

4. Go to the Advanced Search table, search for: Parts | Filename equal to 1.txt 

5. Click Run Search button.  Results: Part1 can be searched successfully. 

8391087 

20963746.6 

Web Client / Common Services  

Issue: Edit Rule and Remove Rule buttons on Relationship tab are active in Web Client. 

Root Cause: System did not check the Modify Rule privilege. 

Resolution: Check the select row and its parent object's Modify Rules privilege, both of them have 
privilege, the Add Rule, Edit Rule, and Remove Rule are visible on Quick View window, otherwise, 
they are gray, and there is no response when user clicks the link. 

Verification Steps: 

1. Create a Modify privilege for Changes to not include Changes.Relationship.Rule. 

2. Assign this to User1. 

3. As another user, create a Relationship between one Change object and another (using 
Relationship tab). 

4. Log in to Web Client as User1 and go to the Change > Relationship tab. 

See that Edit Rule button remains Inactive for this user. 

8426435 

7525359.992 

Searches 

Issue: List fields do not display correctly in Advanced Search. when running Advanced Searches or 
Reports that include class Product Service Requests > Non-Conformance Reports, list fields either 
don't display the value at all or display rows for every value in the list. 

Root Cause: The attribute mapping is wrong, the attributes for list/multilist for PSR affected items is 
pointing to PSR p2 table, it needs to be set to ITEM_P2 table. 

Resolution: The issue about multiple rows is fixed with (TMS) Issue 7631725. The second part is 
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because the attribute mapping is wrong, the attributes for list/multilist for PSR affected items is 
pointing to PSR p2 table, it needs to be set to ITEM_P2 table. 

Verification Steps: 

1. Go to Non-Conformance Reports class | Affected Items tab. 

2. Enable PSR_Item.List01, named list01 to Disposition and add PR Disposition List as list value. 

3. Enable Affected Item.Page Two.List03, named Page Two.list03 to Buyer. 

4. Go to Parts > Page Two. 

5. Enable List03, name it Buyer and add Buyer list. 

6. Log in to Web Client. 

7. Create a new NCR (NCRxxxx) with affected items. 

8. Modify the Disposition List to have a value. 

9. Go to the affected part(s) and fill in the Buyer attribute. 

10. Go to Advanced Search, search for = Non-Conformance Reports Cover Page. NCR Number 
Equal to NCRxxxx 

11. Add 'Affected Items.Dispostion' and 'Affected Items.Buyer' to displayed Fields. 

12. Click Apply button.  Results: 'Affected Items.Dispostion' and 'Affected Items.Buyer' list have 
value displayed. 

8504482 

7481784.994 

Searches 

Issue: From Java Client, export of Search results to MS Excel results in browser error. 

Root Cause: This is an IE6-specific issue. (IE 7 and IE 8 work fine.) In our ExportServlet.java, an 
attachment is successfully returned to IE. The error appears after the user clicks open/save button 
in download dialog, this operation is out of control of ExportServlet.java.  

Resolution:  Since this is an issue only with IE6, no fix for this issue. There is no issue with IE 7, 
which is officially supported, or IE 8, which is not officially supported for 9.3.0.1. 

Verification Steps: 

1. User logs into Agile Java Client with IE7/FF3.5.3 

2. Does a Search, then selects Export to Excel. 

3. System opens a Browser and opens MS Excel Option to either Open or Save the Excel File. 

4. When User selects to Open the Excel File results: The CSV and excle file work fine with search 
export data. 
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8528418 

7464251.993 

Folders, Files, and Attachments 

Issue: Unable to download files using the Get shortcut URL.  

Root Cause: the URL is not in the right encoding 

Resolution: Changed files: AttachmentLib.js,Attachment.inc,ObjectUtils,LinkFactory 

Verification Steps: 

1. Log in to Java Client as administrator. 

2. Create a PSR subclass and name it. 

3. Log in to Web Client to create a PSR from the new subclass.  

4. Add an attachment to the new object. 

5. Select the attachment, select Get Shortcut. 

6. Open a new browser, paste the URL, and provide username and password. 

7. File is downloaded without any error message 

8557822 

7558673.992 

Standard Reports  

Issue: Improve performance and scalability of BOM Compliance report and BOM Explosion report. 

Root Cause: Both BOM Explosion and BOM Compliance Reports can only be safely executed for 
BOMs with fewer than 10,000 rows. BOM Explosion and BOM Compliance reports are too slow. 
Both reports can cause server crashes when run for large BOMs (200,000+ bom rows). 

Resolution: Modified files BOMCompliance.java and BOMExplosion.java to improve 
performance. 

Verification Steps:  

1. Log in to Web Client. 

2. Run BOM Explosion or BOM Compliance report on a BOM that has over 200,000 BOM rows to 
compare with a BOM that has fewer than 10,000 rows. 

3. Performance is improved. 
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8561705 

7477973.994 

Standard Reports 

Issue: Running BOM Compliance report and BOM Explosion report generates OutOfMemory error. 

Root Cause: System will load all values of the entire table, so the system may display "Out of 
Memory" if a BOM Compliance or BOM Explosion report loads very large BOMs. 

Resolution: System will only load some fields as user selects Layout, which reduces the 
consumption of memory.  

Verification Steps:  

1. Log in to Web Client. 

2. Run BOM Compliance report or BOM Explosion report. 

3. Performance is improved, no OutOfMemory Error. 

8565874 

Folders, Files, and Attachments 

Issue:  Thumbnails do not show up on BOM table for items with released revisions. 

Root Cause: Because of a problem in the code, the correct Latest Released Revision of the ECO was 
not being passed while loading BOM table. 

Resolution: Pass Latest Released ECO while loading BOM table for each Item. 

Verification Steps: 

1. Log in to Web Client. 

2. Create a Part, navigate to the BOM tab and add some items with Released revision and some 
items without any Released revision. 

3. Access an item without Released rev, add an attachment, navigate to  BOM tab and verify the 
thumbnail. 

4. Access an item with a Released rev, add an attachment, navigate to BOM tab and verify the 
thumbnail. 

5. Thumbnails should display in BOM table for item with no Released rev. 

6. Thumbnails should display in BOM table for item with Released rev. 

8583293 

2-5675634     7528036.994 

Custom Reports 

Issue: Scheduled Reports don't use updated query definition. 
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Root Cause: Not a bug. As designed. The old scheduled report will not impacted by the query 
definition change. For example, if the old qurey try contain prompt parameter attribute, when 
schedule the report, the value is required to input. But if the query is changed and more paramter 
attributes are used, there is no way to change the scheduled report. So the query definition change 
will not impact the scheduled reports. 

Resolution: A warning message is issued to let the user know the change will delete the existing 
schedule. Current workaround is to delete the old schedule report task and then recreate one. 

Verification Steps:  

1. Log in to Web Client as User Administrator. 

2. Create a new Custom Report with Criteria as below: 

   2-1. Search for: items 

   2-2. Criteria condition: Title Block.Description is not null 

3. Save the report and set up the schedule to run this report once every day 

4. Modified the query to add one criteria 'Title Block.Lifecycle Phase in 'Preliminary' 

5. Save the updated query, there is a warning message, click OK. 

6. Go to Layout tab, the original layouts are still there. 

7. Go to Schedule tab, the original schedule information is removed, create a new one. 

8. Go to Historical Report tab, select the new generated report to check the result. 

9. The new generated report should return the objects based on the updated Query definition. 

8584785 

7592890.992 

Standard Reports 

Issue: Scheduled Report output displays incorrect values when previous days are designated. 

Root Cause: The next execution time is used as the base time instead of the current time. 

Resolution: Use the current time as the base time to calculate. 

Verification Steps: 

1. Navigate to Change Activity Report and open Schedule tab to create a new schedule. 

2. On the dialog's step 1, click Next. 

3. On step 2, select a Workflow and Status Changes, click Next. 

4. On step 3, under Schedule Frequency, pick day of the week, set Time to run report. 

5. Select 'Previous' for Report Time Period, enter number of days. 
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6. Click Finish. Check the Schedule Generated report output, it should accurately display the 
previous number of days. 

8629746 

7601299.992 

Folders, Files, and Attachments 

Issue: File Folder mass update only add File Folders to Items. 

File Folder mass updates using the Add File option only adds Folders to Items successfully. No 
errors are produced for the files to the non-Item objects. Able to add Folders and Files to non-Items. 
(Web Client only, Java Client does not have access to objects in PCM or PG&C module.) 

Root Cause: Non-Item objects were not being supported for mass updates. 

Resolution: Added support for mass update of non-Item business objects. 

Verification Steps: 

1. Log in to Web Client 

2. Create a File Folder > Design object. 

3. Add Files and check the object in. 

4. From the Actions menu, select mass update|Attach files. 

5. Add files of the Design to non-Item objects. 

Actual Result:Files are added successfully. 
 

8647954 

7559993.994 

Folders, Files, and Attachments 

Issue: Redlining or viewing a file does not work with error. When attempting to open or redline an 
attachment from File Folder, the following error occurs: "No Supported Files Available". 

Root Cause: While picking the filename from the table, code was using the incorrect column IDs. 

Resolution: Get the correct column ID from the table columnInfo. 

Verification Steps: 

1. Log in to Java Client as administrator. 

2. Navigate to Admin > Classes > File Folders > Files > Attributes: Files tab. 

3. Enable "List01" and assign one default value for it. 

4. Re-order the attribute sequence and make sure the "List01" is the first one. 

5. Log in to Web Client or Java Client. 
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6. Create a File Folder, add a File, and check in. 

7. Do Redline or View the file 

8. File is viewed and redlined without any error message. 

8665369 

2-5959992    7597129.992  

Folders, Files, and Attachments 

Issue: When attempting to access an attachment via a URL shortcut, an "Insufficient Privilege" error 
occurs. 

Root Cause: No privilege check for Items with Changes. 

Resolution: Pass the Change ID while checking the privilege. 

Verification Steps: 

1. In Java Client, create a new criteria and assign the object type to 'ITEMS' and attribute to 
'TitleBlock.Lifecycle Phase Not In Preliminary'. 

2. Create a new privilege for Get, and assign the criteria (created above) to it. 

3. Create a role and assign privileges such as Create, Read, Modify, Discover, and the "Get" 
privilege on Items and Changes. 

4. Create a user and assign the above role to the user. 

5. Log in to Web Client as the user just created. 

6. Create a Part and add attachments to it. 

7. Create a Change against the Part. 

8. Assign the values for LifeCycle Phase other than Preliminary and New Rev from the attachment 
row. 

9. Move the Change to Released status and navigate to Attachments tab of that Part. 

10. Select the attachment row and select Get. File is downloaded successfully. 

11. Select the attachment row and select Get Shortcut from More menu. 

12. Paste the URL in the new browser window and authenticate it. The file is downloaded 
successfully. 

8716577 

7606509.994 

Searches 

Issue: Advanced Search show incorrect data if add format display column. 
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Root Cause: 1. When executing advanced search on items, if user included BOM.Item Number in the 
search output, the columns are conflated. This issue has been fixed and the fix is checked into 
9.3.0.1 already. 

2. The other issue is that, even though BOM.Item Number is displayed as link, clicking on it or doing 
quick view leads to the parent item and it is the same behavior on 9.2.2.7 as well. 

Resolution: Server side does not support the second hyperlink of one row. 

Verification Steps: 

1. Log in to Agile. Create Item P1. 

2. Add some parts to a BOM for P1, such as P2, P3, P4, and P5. Save. 

3. Go to Advanced Search table, search Items/Parts and move the BOM.Item number into the 
displayed field. 

4. Click Apply button. 

5. Click Search button. 

6. The object displayed correctly with BOM.item number 

7. Click BOM.item number link. The BOM.item object is opened correctly. 

8719872 

7594015.993 

Web Client 

Issue: Subclass dropdown list on Create Object does not work if the focus was outside dlg. Unable 
to create Items using Firefox browser 

Root Cause: In Firefox, if the create dialog window is opened before the menu hides, the focus is lost 
from the dialog window and subclass list element does not show properly. This doesn't happen 
always and it was noticed mainly when the mouse is over the Create menu. 

Resolution: Launch the Create dialog after 800ms so that Create menu closes and the focus is set 
on the Create dialog. 

Verification Steps:  

1. Log in to Web Client. 

2. Click on Create New and select Parts. 

3. Make sure that the mouse focus is outside the Create dialog that gets launched. 

4. Now click on the dropdown box on Create dialog to select a subclass, see that the attributes list 
isn't getting loaded. 

5. If you click on dropdown box again, it does not expand. At this point, close the dialog and try 
again. 
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8798574 

2-5825331   2-5985174    2-5997719    7650924.994 

Standard Reports 

Issue: Cannot run the legacy BOM comparision report properly in 9.3. 

Root Cause: Find legacy BOM Comparison Report interface does not seem to work all the way to 
make all the selections. The Add Items button does not bring anything up. Also no option to Select a 
report output format: PDF, WORD, EXCEL, HTML, or   STANDARD on step 1. 

Resolution: Files Changed: rptselectcompattr.jsp, PCReportFinishStep.java, 
RptBomCompareAddItemStep.java. 

Workaround: No workaround for more than 2 parts. Compare only 2 parts, then they can use the new 
one BOM Comparison Report. 
 

8795265 

2-3252880      7638578.993 

Web Client 

Issue: Item description in Advanced Search results cannot identify the return character. 

Root Cause: The read-div of MultiText values (example: Item Description) does display in multiple 
lines when the value contains new line characters. The entire value is shown in a single line filtering 
out the new line characters. 

Resolution: Fixed the code to display in next line when the value contains new line character. 

Verification Steps: 

1. Log in to Web Client. 

2. Create an Item and enter description in multiple lines. 

3. Search for that item and in the search results table, click on the description column and you see 
the read-div doesn't show the text as entered by the user. 

8813338 

2-6022580     7740515.992 

Web Client 

Issue: Attribute dropdown list on Advanced Search does not show full name of long fields. 

Root Cause: In Firefox, the attribute names of the list elements doesn't show in full when the option 
value is large. This is a default behavior of the Firefox browser. 

Resolution: Fixed to show the full attribute name as a ToolTip. 
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8833997 

2-5819709   7645077.994  

Relationships 

Issue: Unable to modify Item Relationships if setup Modify privilege with $CURRENTREV. 

Root Cause: Set IClientContext error, so no privilege for Read Object. 

Resolution: Move the Read privilege check together with Modify privilege check. 

Verification Steps: 

Log in to Java Client as user 'admin'. 

Create new criteria 'All Item Relationship_tommy' in Items class, with these criteria conditions: 

Items $LATESTREV is Introductory Or 

( $CURRENTREV Equal To $UNASSIGNED  Or 

$CURRENTREV Equal To $STATUSTYPE.PENDING  Or 

$CURRENTREV Equal To $STATUSTYPE.SUBMIT  Or 

$CURRENTREV Equal To $STATUSTYPE.REVIEW  Or 

$CURRENTREV Equal To $STATUSTYPE.HOLD ) 

Create new Modify privilege 'Modify All item relationship_Tommy' as below  condition: 

Privilege criteria: All Item Relationship_tommy 

AppliedTo:Items.Relationships.Name,Items.Relationships.Rule 

Create new role 'Item relationship_Tommy' add above privilege. 

Create new user 'rluser1' with role 'Item relationship_Tommy'. 

Create new parts 'P000003' by user admin. 

Create new ECO 'ECO-000003' (Workflow: default change order) and add P000003 as affected 
item by user 'admin'. 

Add parts 'P000005' as relationship data for parts 'P000003' successfully by user 'rluser1'. 

Released ECO-000003 with Rev A1 for parts 'P000003' by admin user rluser1 is Unable to add new 
relationship data for parts 'P000003' in Rev-A1 >>>that's correct. 

Crete another new ECO 'ECO-000004' (Workflow: default change order) and Add P000003 as 
affected item by user 'admin'. 

Add parts 'P000005' in pending rev as relationship data for parts 'P000003' should not fail with error 
'Insufficient privilege' by user 'rluser1'. 

Expected Results: Modify Privilege is set up for Item relationships if current status is not released. 
First ECO can modify Item relationship Data till it‟s not released.  Second ECO also should be 
allowed to modify Item relationship data in not released status. 
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8873288 

2-5975790   7683013.994 

Web Client 

Issue: Long user group name can not be displayed completely in user selection dropdown. 

Root Cause: The width of the user group name select element is fixed. If the user group name is 
larger than the width, the name gets truncated and there is no way to see the full name. 

Resolution: Fixed to show the full name as the tooltip. The tooltip shows up when the mouse is over 
the user group name. 

Verification Steps: 

1. Login to Web Client. (on IE) 

2. Create a User Group with a long name. 

3. Go to any object and launch send or comment or change status or similar action with a user 
control. 

4. Launch the palette on user control and look at the drop-down on the user control, Put mouse 
focus on user group name field. >>the full name can be displayed as a tool-tip. 

8882446 

2-5674431 

Web Client 

Issue: Fill down on tables broken, if there are only 30 rows. 

Root Cause: When there are only 30 rows, UI server code miscalculates the number of pages and 
submits an extra server call which was causing this issue. 

Resolution: Fixed the code to calculate the number of pages correctly and to avoid the extra server 
call. 

Verification Steps: 

1. Login to Web Client. 

2. Create an item; add 30 rows to the BOM table. 

3. Change value on Qty and do fill-down action 

>>Values can be filled down as expected. 
 

8882633 

2-5928399   0 7663286.994 

Searches 

Issue: Advanced Search returns no record if Cascading List contains "&" character. 
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Root Cause: In search.js, List Value "A&B" is parsed as "A not A&B". So need to specially handle 
symbol '&' with encodeURIComponent(). 

Resolution: Fixed the code to do special handling for "&" character. 

Verification Steps:  

1. Login Java client to create a new Cascading List "CASD_Test1" with the following values: 

Level 1 --> A&B: Test list value contain symbol. 

Level 1 --> A and B: Normal list value without symbol. 

2. Assign this new created cascading list as Page2 column 'Cascading List test' for parts. 

3. Add list value "A&B" for parts P000099 and P000100. 

4. Add list value "A and B" for parts P000102 and P000103. 

5. Create a new Advanced Search "Cascading_search_Test1" with the following conditions: 

> Class: Items 

> Search Type: Object Search 

> Condition: Cascading List test in by prompt. 

6. Run this search with "A&B" as prompt value. There are 2 items (P000099 and P000100) in the 
result. 

7. Save this new created Advanced Search into Global Searches with the same name 
(Cascading_search_Test1). 

8. Run this search from Global Searches with "A&B" as prompt value. The value can is displayed 
correctly. 

9. Run this search again from Global Searches with "A and B" as prompt value. There are 2 items 
(P000102 and P000103) returned. 

8900335 

2-5998385    7776316.992 

Java Client 

Issue: Missing currency exchange rates node in Agile 9.3 Java Client when license is enabled. 

Root Cause: The Currency Exchange node was only enabled if the PCM module license turned on 

Resolution: Made the Currency Exchange always enabled 

Verification Steps: 

Log in to Java client. admin/agile. 

Go to Admin tab > Server Settings > License > Modules. 

Set PCM=Yes and PPM=No. 
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Restart the server. 

Login to Java client as administrator. 

Go to Admin tab > System Settings. 

Expected: Currency Exchange Rates node should be available. 

Note: Validate the same for other combinations also: PCM/PPM – No/Yes; PCM/PPM – Yes/Yes; 
PCM/PPM – No/No. 

8931508 

2-5745913   2-6019267   7778551.992   7776692.992 

Folders, Files & Attachments 

Issue: Privilege error on markup/redline files. 

Root Cause: there was no Check for this particular privilege. 

Resolution: Verify the privilege and then continue for operation 

Verification Steps: 

Precondition: Create user to create markup files and 'Attachment Redlines for Self' privilege 
enabled. 

1. Log in to Web Client as user. 

2. Create a Part. 

3. Add supported attachments. 

4. Create a change on part. 

5. Create markup on the attachments. 

8937472 

2-5839544   0 7717498.994 

Searches 

Issue: Get error message when inserting criteria in Advanced Search. 

Root Cause: Advanced Search UI could not remember the location of new inserted criteria row and 
led to this issue. 

Resolution: Fixed to code in hashtable.js to remember the location. 

Verification Steps:  

1. Log in to Web Client. 

2. Go to Advanced Search. 
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3. Set two lines of criteria, for example: Number is not null and Rev is not null. 

4. Click the first line of Add button to insert one line between the two lines of criteria. 

5. Set criteria, like Rev Release Date is null. 

6. Run search. 

Results: The objects are returned correctly. 

9167309 

Web Client 

Issue: Affected Items (AI) table on ECR, StopShip and Deviation objects is too small. On ECR, 
StopShip, and Deviation objects, the height of Affected Items table is too short and it is hard-coded. 
Also, since there is no Redline table on these Affected Items tabs, the full display mode is not 
available. 

Root Cause:The AI table of ECR, StopShip and Deviation objects doesn't occupy the full available 
space and occupies only half of the avaible area. 

Resolution: Fixed the code to occupy the entire available area so that more rows are displayed. 

Verfication Steps: 

1. Log in to Web Client and access any ECR, StopShip, or Deviation. 

2. Open Affected Items tab: the table height is extended to the normal size as other tabs that have 
one table on that page, just as on BOM table. 
 

Product Collaboration 

8304483 

7298496.993 

Manufacturers / Mfr. Parts 

Issue: User who does not have appropriate Modify privilege is still able to redline Manufacturer data 
while in Java Client. 

Root Cause: There are two issues involved here (please refer to step 8 below): the major issue is, the 
BOM row can be redlined deleted even though the user does not have Modify privilege on any BOM 
(AppliedTo) attributes. We reproduced this issue in 93 (and this issue is verified fixed on 9301). 

The minor issue is, the Edit/Delete buttons appear as active even though the user does not have 
Modify privilege on any BOM (AppliedTo) attributes.  

Resolution: This is as designed behavior per Java Client evaluation. 

Verification Steps: 

1. Create a role "TestRole". 
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2. Add Discover, Read, Create privileges to TestRole for Items, Changes, Manufacturers, 
Manufacturer Parts. 

3. Create a Modify Items privilege, remove all the BOM and Manufacturers attributes from its 
selected AppliedTo list. Add this privilege to TestRole. 

4. Create a new user "TestUser". Assign two roles to TestUser: My User Profile and TestRole. 

5. Log in to Java Client as Administrator (with standard Admin roles & privileges). Create Parts 
P001 and P002. Create Manufacturer Part MPN001, Open P001 BOM table, add P002, open 
Manufacturer tab, add MPN001. 

6. Log in to Java Client as TestUser. 

7. Search P001. 
a. On BOM Table, both Edit and Create icons are disabled. Select P002 row, the Remove 

icon is also disabled. 
b. On Manufacturer table, both Edit and Create icons are disabled. Select MPN001 row, the 

Remove icon is also disabled. 

8. Search C001. 
a. Click the Redline BOM icon to bring up editing dialog display. Note the fields can be 

actually modified. Select P002 row, click Remove icon, it displays Insufficient Privilege 
message. 

b. Click the Redline AML icon to bring up editing dialog display. Note the fields can be 
actually modified. Select MPN001 row, click Remove icon, it displays Insufficient Privilege 
message. 

8324876 

2-1558584     7369612.993 

Item & BOM / Product Collaboration 

Issue: Users are unable to edit BOM attributes; also, field names are appearing incorrectly. 

Root Cause: The first issue is caused by missing READ ITEM.BOM.SITE privilege. The second issue 
is "As Designed" behavior. Research on Item_vs_Find_Number.doc shows that 44E6145 is a 
Document object whereas 44E5582 is a Part object. BOM table column names/orders are 
configured differently for Document and Part in LSI db. They are shown correctly according to the 
selected AI row object type. 

Resolution: The first issue has been already fixed. The workaround is to assign the user that 
privilege. 

Verification Steps: 

1. Login into Java Client by admin. 

2. Create a userA; Make sure user A does not have read item.bom.site privilege and "Enforce Field 
Level Read" role is assigned. Also, userA has read/modify/discovery item/Changes privilege. 

3. Login into Java Client by userA. 

4. Create a part1, part2; add part2 as BOM of part1. 
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5. Create a C001 against this part1. 

6. Go to AI table, try to redline edit BOM. Result: For the Site column in Redline BOM tab, it will 
display icon of No Privilege, User can redline edit BOM and save. 

7. Login into Java Client by admin, and Make user A has read item.bom.site privilege. 

8. Login into Java Client by userA. 

9. Search C001, and redline BOM again. User can redline edit BOM and save. Icon of No Privilege 
disappears. 

8340624  

7384780.994 

Java Client / Product Collaboration 

Issue: Title of the error message when observer with insufficient privilege is deleted is not accurate. 

Root Cause: None Available 

Resolution: Changed these files: 
PowerClient\src\com\agile\ui\pcclient\pc\CommandAddApprovers.java 
PowerClient\src\com\agile\ui\java\resources\PCResources.properties 

Verification Steps: 

1. Log in to JavaClient 

2. Create userA, only add below privileges: 
    Creator can read and discover object he or she created 
    My User Profile 

3. Create ECO, and route to CCB status. 

4. Go to Workflow tab. Click Add Approver/Observer button to add userA. 

5. It should display Title and Message as: 
 Title: "Add Approvers and Observers" 
 Message: "Observers <user name> do not have necessary privileges and have been 

removed." 

8352274   

7460069.992 

Java Client / Product Collaboration 

Issue: Missing attachment icon in some PCOs 

Root Cause: This issue is same as 7105303 (fixed in Rel. 9.2.2.5 and merged to Rel. 9.3 already). It 
is not reproducible in Rel. 9.3.0.1. 

Resolution: None Available 
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Verification Steps: 

1. Log in either client (Web / Java). 

2. Create a Mfr. Part, like MFR1, add attachment for it. 

3. Create a Part , like Part1, add MFR1 to Mfr. tab 

4. Create an MCO against Part1, go to redline Mfr. tab, it should show attachment icon for MFR1. 

8392233 

7489919.992 

Changes 

Issue: System show warning message   

Root Cause: It's not reproducible in 9301 

Resolution: [None Available] 

Verification Steps: 

1. Log in to Web Client or Java Client. 

2. Create a Change Order. 

3. Move status from  Pending to Submit, then from Submit to Review, add a user as observer, do 
not add approver. 

4. Do audit release or move to next status. 

5. It can move to release status without any System Warning Message. 

8545265 

2-5676856     7505437.994 

Web Client / Product Collaboration 

Issue: When redlining field on ECO/MCO, all text fields with spaces also redlined. 

Root Cause: Page rendering is different in 9.3.0.1. This issue is not reproducible in 9.3.0.1. 

Resolution: None Available 

Verification steps: 

Precondition: 

1. Log in to Java Client as an Administrator. Go to Admin > Data Settings > Classes > Items. 

2. Select "All " as "Include Characters" field for below attributes: 
 Title Block:: Number 
 Title Block:: Description 
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 BOM.Ref Des 
 BOM.Find Num 
 BOM.Qty 

Verification: 

1. Log in to Web client. 

2. Create a part P001; make sure Number and Description all contain consecutive spaces. 

3. Do Advanced Search for P001 with criteria equal to its own value, so that P001 displays well on 
Search Results table. 

4. Save P001 as P002, add P002 to BOM of P001. 

5. Go to BOM tab, modify Ref Des to contain consecutive multiple spaces, then save. 

6. Create a Change C001 against P001, then redline BOM, modify Quantity to contain consecutive 
multiple spaces, and save.  

7. Quantity attribute should display correct value, other attribute like Ref Des should keep its original 
value, as it has not been redlined. 
 

8556797 

7574007.992 

Java Client / Product Collaboration 

Issue: System does not consistently permit user to select multiple values with Ctrl key. When 
selecting multiple values from a MultiList using Ctrl key, all the values are not transferred to the 
right side of the box. 

Root Cause: Do not drag the mouse while Ctrl + clicking list entries. Mouse drag/move is used for 
a single-interval selection. 

Resolution: Changed this file: 
PowerClient\src\com\agile\ui\java\component\MultiDynamicListPanel.ja
va 

Verification Steps: 

1. Log in to Java Client. 

2. Create a list, add more than 1000 values to it, and assign this list to ChangeOrder.Product 
Line(s). 

3. Create an ECO, click 123 button to assign number and click OK. 

4. Click Product Line(s) dropdown list, focus on pop-up dialog. 

5. Using Ctrl key, select MultiList and add it to the right-side box. Values selected using Ctrl key 
value should display in the right-side box. 
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8573470 

2-5901888    7533006.993 

Item & BOM / Product Collaboration 

Issue: Unknown number object does not exist error. 

Root Cause: There are several issues here: 
 1st issue: Unknown number object does not exist error. This error can be reproduced in 

9227; it can happen on BOM.MultiList01–03. A quick workaround is to use 
BOM.MultiList04–15 instead of 01–03. 

 2nd issue: From BOM tab, multiples will be truncated to 31 values, however, in Item P2, all 
the values (more than 31) can be correctly shown. 

 3rd issue: sometimes BOM table shows no value for overflow MultiList attribute (you might 
need to click refresh button to see that). 

Resolution: 
 The first issue can be easily solved. 
 The second and third issues, similar bugs are already filed against search (8254103 & 

8278310); the solution on these bugs will impact this one. 

Verification steps: 

1. Log in to Java Client. 

2. Make sure User Group list contains more than 32 User groups; meanwhile, each Name of User 
Group is a seven-digit. (e.g., UG00001–UG00033) 

3. Enable Part.P2.MultiList01 field, then assign that User Group list to Part.P2.MultiList01 field, 
make sure UserA user has Read, Modify privileges to the relevant fields. Enable Item P2 
MultiList01. 

4. Log in to either client as UserA. 

5. Create a part named P001, and add newly created user groups into P2 MultiList01 by drag/drop 
method, then Save this P001 as P002. 

6. Search P001, then add this P002 as BOM of P001, then click the Refresh button. All works well. 
"UNKNOWN NUMBER OBJECT DOES NOT EXIST ERROR" error message does not appear. 

8581531 

7492206.994 

Java Client / Product Collaboration 

Issue: Application throws error after user clicks Show BOM Tree button, and it does not expand the 
BOM. 

Root Cause: The issue is related to the loading of child rows with wrong site Key & change Key. The 
site Key and change key are getting reset when the user clicks on one of the node which has 
different site Key or change Key. 
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Resolution: This issue is not reproducible with the latest 9.3 release. The code 
(CMTreeQueryIterator.java) which caused this issue is changed in 9.3 as part of another bug. 

Verification Steps: 

1. Log in to Web Client as admin. 

2. Search for DW5554M68C4, open the part, click Navigator button. 

3. On the left pane, expand first instance of W04M68C, click M68C-4~MASK to show mask details, 
the information of M68C-4~MASK displays correctly on right pane. 

4. Expand second instance of W04M68C, click M68C-4~MASK to show mask details, the 
information of M68C-4~MASK also displays correctly on right pane. 

5. QuickView each instance, all function correctly. 

8622958 

2-5819051    7644508.992    2-5827071 

Item & BOM / Product Collaboration 

Issue: Part History tab does not track user name for relationship changes. 

Root Cause: This bug has been fixed in 9.3. 

Resolution: None Available 

Verification steps: 

1. Log into Web Client or Java Client. 

2. Create a Change Order named C001, move to Submitted status. 

3. Create a part named P001, go to Relationship tab, add C001 as relationship. 

4. Add rule to "when P001 is Production, set C001 to Submitted", and save it. 

5. Go to History tab, in User column, there are two records as follows: 
 Action::Add Related Object, user information should display in User column. 
 Action::Update Related Object, user information should display in User column.  

8673536 

2-6011297    7630272.992  

Standard Reports 

Issue: Error running BOM Explosion Report. 

Root Cause: Since the user does not related privilege to load value of a field, so the field is null, it will 
throws an Exception when try to get value from null. 

Resolution: Check if it is null before use it. Modified file BOMExplosion.java 
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Verification Steps: 

1. Log in to Web Client as vlillie@apple.com/agile. 

2. Run BOM explosion report for BOM MC126Z/A. 

3. Returned report results are good, with no unexpected error. 

8685979 

7587699.994 

Changes / Product Collaboration 

Issue: Transfer Authority is being deleted by the other person without notifiying the original person. 
Transfer Authorities are being deleted, then the cancellation Trtansfer Authority notifications are 
sent to users and the Transfer Authoriy records are deleted in Settings; no user has deleted any 
Transfer Authority (TA). 

Root Cause: in the notification template, the Cancel User default is the Create user. 

Resolution: Update the template with Cancel by the LastChange user. 

Verification Steps: 

1. Log in to Java Client as administrator. 

2. Go to System Settings > Notification > "Transfer Authority, Cancel" notification. 

3. Set Notification Type as Email and Inbox. 

3. Create three super-users named UserA, UserB, UserC, ensure that their email addresses are 
correct. 

4. Create a TA from UserA to UserB, select Criteria: All Change Requests. 

5. UserC log in to Java Client, then delete newly-created TA. 

6. After waiting for some time, UserB logs in to Web Client/JavaClient. 

7. Check the Inbox tab and Email system, check Subject and Body information. 

Result: Subject display as following: 

A Transfer-of-Authority has been canceled, by UserC for the Approval of All Change Requests. 
Body of notification displays in this manner: 

TRANSFER:  Approval of All Change Requests for UserC for the period 09/14/2009 10:18:05 AM 
BST to 09/21/2009 12:00:00 AM BST is no longer assigned to UserB. This transfer was canceled by 
UserC. 

8693842 

7596459.994 

Workflows / Product Collaboration 

mailto:vlillie@apple.com/agile
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Issue: Trouble report with relationship required fields does not always autopromote. 

Root Cause: Adding row in relationship table not trigger autopromote on routable object. 

Resolution: Change code to make sure : Adding row in relationship table do trigger autopromote on 
routable object. 

Verification Steps: 

1. Log in to Web Client or Java Client as administrator. 

2. Create a problem report PR001, change status to Review Status. 

3. Go to Cover Page, modify Description, and save it. 

4. Go to Relationship tab, add an existing Part or create a new Part. 

5. PR001 can be autopromoted to Released Status. 

8798574 

2-5825331      2-5985174      2-5997719      7650924.994  

Standard Reports 

Issue: Cannot run the legacy BOM Comparision Report properly in 9.3. 

Root Cause: Since there is a new BOM Comparison Report in 9.3, the legacy report was removed 
from 9.3. 

Resolution: Enable the legacy BOM Comparison Report. 

Verification Steps: 

1. Log in to Web Client. 

2. Navigate to the Reports folder on left pane > Standard Reports > Product Reports > legacy BOM 
Comparison Report. 

3. Prepare the report, e.g., in Step 1, select a report output format. In Step 2, select Items for the 
report (add Items by Add button and Custom Search). 

4. Go through other steps, click Finish and run the report. 

5. Check the report output, the report results should return well. 

8890982 (also see 9131656 in Known Issues: Product Collaboration) 

2-5886242    7699116.993 

Web Client / Product Collaboration 

Issue: When modifying Reference Designator ("Ref Des"), a space is added after the comma. 

Root Cause: None Available 

Resolution: Modify GridUtil.java 
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Verification steps: 

1. Log in to Java Client as admin. 

2. Go to Classes > Items > Parts > User Interface Tabs > BOM > Attributes: BOM tab > Ref Des. 

3. Click New Character Set > Valid Characters Set 
1234567890ABCDEFGHIJKLMNOPQRSTUVWXYZp:_- make sure it does not include a character 
that is equal to the current value of Reference Designator Range Indicator in Preferences. Make 
sure Ref Des Attribute uses the newly created character sets. 

3. Log in to Web Client. 

4. Create two parts, P001 and P002, and add P002 as BOM of P001. 

5. Create a change C001 against P001, redlineBOM. Redline the Ref Des – use upper case with 
comma (e.g., AB, CD), redline Quantity to be 2. It can be redlined without any error message, the 
redlined data display correctly. 

9083027 

Web Client / Product Collaboration 

Issue: The Reference Designator (Ref Des) on Redline BOM table does not display the same as in 
PLM 9.2.2.x. 

Root Cause: In 9.3, per the new UI design, the existing Ref Des and redlined Ref Designators are 
displayed in two separate lines. It is very difficult to determine what was "redline removed" and what 
was "redline added". 

Resolution: This issue has been fixed, that is, for Redline BOM table. (Issue 9176820, which has 
been approved to defer to 9302, will fix Item BOM table.) 

Verification Steps: 

Precondition: Reference Designators Allow Range Expand Collapse is set to Collapse. 

1. Log in to Web Client. 

2. Create P001, P002, then add P002 as BOM of P001. 

3. Go to BOM Tab, modify Qty=100, Ref Des = R1–R100, then save it. 

4. Create C001 against P001, then BOM Redlines. 

5. Redline Find NUM=10, with Ref Des attribute as below redline: 

Add R0, R200. 

Remove R4, R5, R11, R12. 

Expected Results: 

1. For Find NUM Column, 10 displays in red, and default value:0 displays with a red strikethrough in 
the bottom row. 

2. For Ref Des Column, in the top row, it displays R0, R1–R3, R6–R10, R13–R100, R200. 
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Meanwhile, R0, R200 show displays in red, the old values display in black. Also, Tip information 
displays in the same way. 

  In the bottom Row, it display R4, R5, R11, R12 with a red strikethrough in red color. Also, Tip 
information display in the same way. 
 

Product Cost Management 

8360663 

7393125.993    7482631.992 

Price / PCO 

Issue: Unable to create a Part using Save As from an existing part when a Price is attached to the 
existing Part. 

Root Cause: User with only Component Engineer role does not have save as privilege for Price 
objects. The Insufficient Privilege error is thrown during the Item/Mfr. Part's "SaveAs". 

Resolution: A new flag used during Item/Mfr. Part "SaveAs" determines whether the Insufficient 
Privilege error is to be thrown or ignored. Able to do SaveAs on the Item/ Mfr. Part when the user 
has only Component Engineer role. 

Verification Steps: 

1. Create an Item with a Price object associated. 

2. Log in as a user with only the Component Engineer role. 

3. Do a Save As on Item from step 1. 

4. Save As is successful, there is no privilege error and no Prices are copied. 

8520265 

7497297.994 

Price / PCO 

Issue: Pricelines that were created in Import are removed from the Items Prices tab when 
publishing/releasing a PCO. (If the PCO is returned to Pending, the Pricelines are displayed again.) 

Root Cause: While loading, it was not retrieving valid price lines. 

Resolution: Fixed loadPriceTable() method.  Items.Prices tab displays the price correctly after 
releasing the PCO for the Imported Prices. 

Permnent resolution can be achieved only when PriceLine redlining on PCO revisions are fixed. 

Verification Steps:  

1. Import published Price Lines for an Item. 

2. View Price Lines on Item > Prices tab (Price Lines are showing, for example, Currency Code, 
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Total Price, and so forth). 

3. Add Price object for the published Price Lines to a PCO. 

4. Release the PCO. 

5. View the Item's Prices tab. 

8557137 

7574267.992 

Price / PCO 

Issue: Cannot publish Quote History to Item from Sourcing Project. 

Root Cause: - the system designed to show prices of MPNs that belong to the selected item's rev. In 
the customer case: 

- there were 3 MCOs released on the item RSS04017 which affect the list of prices: 

- M07802 changed mfr name for RC1005F1004CS from SAMSUNG to SAMSUNG ELECTRO-
MECHANICS. That effectively created a new MPN, so the prices belonging to the old MPN do not 
show up for item rev before the MCO release date. 

- M07560 changed mfr name for RC0402FR-071ML from YAGEO CORPORATION to YAGEO 
CORP.  It had the same effect for filtering out its prices. 

- M08176 seems deleted and added again WR04X1004FTL during redlining. Even effectively the 
MPN was not deleted an entry in the manu_by table was introduced indicating that MPN was 
deleted, and added. In the code, when sql retrieved rows from manu_by table the order of rows was 
not guaranteed to be the same as order of changes, so if mpn has been deleted and added if the 
row of deletion came after the row of addition it was considered as deleted. 

Resolution: since 9.3 the change of mfr is not allowed under an MCO, so the first issue no longer a 
problem. For the second issue (delete/add) forced the order to be the same as order of changes. 

Verification Steps:  

1.  Log in to Web Client, for Agile PCM, open the Project SUP00080. 

2.  Go to Analysis tab, filter the view by Item number=RSS040017. 

3.  Open Part RSS040017, click View from Item master. 

4.  Go to the Prices tab, check the prices published for the MPNs. 

8795939 

2-6001594 

Web Client 

Issue: Selection behavior is not proper when we execute reports from Analysis tab. 

Root Cause: The system is considering all the items in analysis tab for report execution, even though 
we select one. 
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Product Governance and Compliance 

8629744 

7607894.992 

Declarations 

Issue: In Part Declarations, when importing Manufacturer Parts, the flex-fields are not importing 
correctly. 

Root Cause: The bug is triggered only when user has configured mapping between user-created flex 
attribute in Part/Mfr. Part PageTwo and Part/Mfr. Part composition flex attribute. The scenario 
cannot be reproduced if no mapping exists between user-created flex attribute in Part/Mfr. Part 
PageTwo and Part/Mfr. Part composition flex attribute. 

Resolution: Material Declaration Part DAO - set values. 

Verification Steps:  

1. Create a flex-field for Manufacturer Parts PageTwo: Flex_List05 (Yes/No list). 

2. Enable a List (List04) field for a Parts Declaration Manufacturer Parts, name it Flex_List05 
(Yes/No list). 

3. Map data to Manufacturer Parts.Page Two.Flex_List05 field for the Manufacturer Part to list04. 

4. Import Declaration with Mfr Part and let FLEX_LIST05 have one value. 

5. Create an Excel with the following fields imported into Part Declaration: 
 Name: MD00004 
 Manufacturer Name: MFR_01 
 Manufacturer Part Number: MFRP001. 
 FLEX_LIST05: No 

6. On Declaration MD00004 Manufacturers tab, expected result: Flex_LIST05 field is filled in with 
value No. 
 

Product Portfolio Management 

7085189 

18966634.6 

Web Client PPM 

Issue: The Programs frame in the Dashboard does not size width or height correctly, if changed to 
Minimized from Maximized, and window is changed to smaller size then back again.  

Root Cause: Design change. 
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Resolution: The dashboard widgets have been enhanced in 9.3. This issue has been taken care as 
part of this enhancement. 

Verification Steps: 

1. Log in to Web Client and go to Dashboard. 

2. Navigate to Projects tab or any other tab of Dashboard. 

3. Restore the window size and check the widgets displayed. 

4. Re-size or maximize the window and check the widget displayed. 

Result: Widgets are getting re-sized properly. 

8403018 

7510747.992 

Resource Management 

Issue: Health Status does not roll up properly for Quality Status and Resource Status. 

Root Cause: This is as-designed. If the activity has more than one child activity, the parent program 
values change based on other child activities in this scenario. In this case, since the parent has only 
one child, and its rollup Health Status is set to No, the previous value on the parent is retained. The 
rollup depends on the value of the rollup Health Status. If it is set to Yes, the child values roll up to 
the parent Program; if set to No, previous values are retained on the parent.  

Verification Steps: 

1. In Web Client, create a Program with Task, Subtasks, and Gates. 

2. Edit the Rollup Health Status value to No for all Task, Subtasks, and Gates. 

3. Now go to any one of those objects and edit Quality Status or Resource Status attribute and also 
edit Roll Up Health Status attribute to 'Yes'. 

4. Check the Health Status of child and the root. (Note: Quality/Resource Status value is updated 
on both task and root.) 

5. Again edit the Roll Up Health Status attribute of those objects to No and click on Save. 

6. Check the Health Status of child and the root. 

Result: After step 5, in the root Quality Status or Resource Status, attribute values are editable. 
User is allowed to edit the Resource Status and Quality Status values for the root if rollup Health 
Status attribute is set to No for all the children. 

8521055 

2-5809422      7453177.994  

Content Management 

Issue: Error: PRJD-000027: XXX Required fields not set for: Description while creating Program 
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from Program template. 

Resolution: The fix is in itemCoverPageDao::loadTable to explicitly set item description value into the 
loaded row in cache. 

Verification steps: 

1. Log in to Web Client. 

2. Create a Program as Template (Prg01). 

3. Navigate to Content tab. 

4. Add Document as content (DOC01). 

5. Edit Mandatory attribute to Yes and Autonumber attribute to Document Autonumber. 

6. Now create a new Program Prg02 from Prg01. 

7. Select only Content checkbox and click Finish. 

Result: No error message is displayed 

8676655 

7573410.994 

Dashboard 

Issue: Dashboard export puts data in wrong columns. 

Root Cause: When , [comma] is present in the text, that whole text is surrounded with " [quote 
marks]. Along with the ; [semicolon], if a " [quote mark] is also present in that text, it considers the 
"text-up-to-quote-marks" as one block of text and the remaining text as a different block. 

Resolution: Escape quotes in the code. 

Verification Steps:  

1. Log in to WCM. 

2. Create a few Programs with comma, semicolon, and quotes in the name (such as  
"test,program;). 

3. Go to Dashboard > Projects tab. 

4. Check the Program in the table. 

5. Export the data displayed in the table and check the data displayed in Excel. 

Result: Data is displayed properly, there is no misalignment of data in columns. 
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8686148 

7678565.992 

Gantt Chart 

Issue: When attempting to launch Gantt Chart from one PPM object, the following error occurs:   

Error in Java Console:  java.lang.NullPointerException  at 
com.agile.ui.gantt.utils.GanttUtils.getAttribute(GanttUtils.java:1193) 

Root Cause: getAttribute() of GanttUtils throws Null pointer exception, since no Gates 
subclass is enabled. 

Resolution: Handle null pointer exception in getAttribute() of GanttUtils when all the 
subclasses are disabled. 

The getDefaultSubClass() method in GanttUtils has been modified to accept a Boolean 
parameter enabledOnly. When set to True, it returns only an enabled subclass (this behavior is 
necessary in GanttAction / inlineCreateNewActivity() method). From the GanttUtils 
getAttribute() method, we pass False, so the disabled subclass is also returned. 

Verification Steps: 

1. In Web Client, create a program (Program1) with Task and Gates. 

2. Log in to Java Client. 

3. Go to Admin > Data Settings > Classes > Gates. 

4. Disable all the subclasses present under Gates class. 

5. Now log in to Web Client. 

6. Open Program1. 

7. Launch Gantt chart for Program1. 

Result: Gantt chart is launching without any exceptions. 
 

Product Quality Management 

8468889 

2-2071944      7436556.994 

Issue Tracking / Product Quality Mgt. 

Issue: Trouble report does not display Failure Mode on Affected Items tab. 

Root Cause: The issue is caused by not updating Affected Items.FailureMode when changing 
subclass type of Affected Items. That is, after Item subclass is changed, the original failure mode 
value does not match any entry in the new Failure Mode list. 

Resolution: when loading PSR's AI tab & Item's Quality tab, return the failure mode value <change-
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file-list> apcm\src\com\agile\psi\server\psr\PSRAIRow.java; 

apcm\src\com\agile\pc\cmserver\base\BasePSRRow.java 

Verification Steps: After changing item object's subclass, check the failure mode value under PSR's 
AI tab & Item's Quality tab. 

Precondition: Log in to Java Client, create two subclasses from the Parts class: 

    a. Subclass: Part, Failure Mode List - [Part] as Value1 

    b. Subclass: NewPart1, Failure Mode List - [NewPart1] as Value2 

1. Log in to Web Client/Java Client. 

2. Create PR1, add Part1 (subclass Part), set its "Failure Mode"; column to value1. 

3. Search Part1, and Modify Part1 Subclass ( e.g: from Partto NewPart1). 

4. Go to Affected Items tab of PR1, "Failure Mode" column should still display value1. 

5. Do Advanced Search for this PR1, search PR1 objects (customize the output to show "Affected 
Item. Failure Mode" and "Affected Items.item Number"). Check the result table. For record PR1, the 
Affected Items.Failure Mode still has previous value. 

6. Now, select this row and modify the Failure Mode value to value2. 

7. Do Step 5 again. For record PR1, the Affected Items.Failure Mode should display the latest 
value: value2. 

8669981 

2-2751634     7551825.994 

Customer / Product Quality Mgt. 

Issue: Performance issue when opening Affected Items tab of PSR (first time and subsequently). 

Root Cause: Server try to load whole change AI table while getting the "rev found" field in defective 
item table. 

Resolution: Not load the while change AI table, just get the field value from DB 

Verification Steps:  

1. Connect CustomerDB to Application Server. 

2. Log in to Web Client as administrator. 

3. Search for PSR object, open up NCMR/SCAR0000003 

4. Click on Defective Items tab, data on that table show in less than 30 seconds. 

5. Then select list for Rev Found and Rev Fixed list, It can focus on selecting list quickly. 
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AutoVue for Agile 

8420922 

2-5862871   7434865.993  

2D Pro Integration 

Issue: Blank watermark when "print preview" the attachment. 

Root Cause: Watermark text not added when attribute not visible. 

Resolution: Concatenate watermark text. The appropriate file was changed.  

Verification Steps: 

1. In Java Client, navigate to Admin > System Settings > Viewers & Files > WaterMark tab. 

2. Select Users Banner & Watermark, Set Print WaterMark = 'YES'. 

3. Set Blank values for Attribute Watermark field. 

4. Enter a value for Attribute Watermark Text field - 'test' and save it. 

5. In Web Client, log in as admin, select admin user, add a file. 

6. View the file, from File menu, select Print Preview in Agile Viewer. 

7. Click OK button from Print window.  

Actual Result: "Attribute Watermark Text -'test' is displayed in viewer window. 

8598391 

2-5860044 

2D Pro Integration 

Issue: Cannot view files attached to non-Revision/Version objects in Linux environment AutoView. 

Verification Steps: 

1. Create a Site or User or ECO. 

2. Attach any supported files. 

3. Try to view the file by clicking link or View button. 

Actual Result: Files are viewed in Agile Viewer. 
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8630445 

21434800.6 

Electro-Mechanical Professional Integration for Agile 

Issue: Cannot view all file types with AutoVue 19.3.2 for Linux for non-Parts (non-Item) objects. 

Root Cause: In Viewer, a filename is displayed as "Filename" + "Rev/Version". Objects other than 
Items and File Folders do not have Rev or Version, so the filename becomes instead "Filename" + " 
" [blank]. Linux is unable to recognize the file if there is a [blank] at the end of the filename. 

Resolution: If it is not an Item or File Folder object, do not append a [blank]. 

Verification Steps:  

1. Create a non-Item object, e.g., Site or User or ECO. 

2. Attach any supported files. 

3. Try to view the file by clicking link or View button 

Actual Result: Files are viewed in Agile Viewer. 

8875424 

2-5750769    7356482.992 

2D Pro Integration 

Issue: Viewing attachment to Item in Pending evision results in invalid filename. 

Root Cause: Item revision is added to filename, when the item is not released the rev may contain 

 „?‟ which is invalid character in filename for Cimmetry hence throws exception. 

How to fix: keep only the alphabets & numbers of a item rev while forwarding request to Cimmetry 

Verification Steps: 

1. Login to web client/Java Client 

2. Create an Item 

3. Add supported files 

4. Create an ECO on Item 

5. Select pending rev and view the file 

Actual Result: File is viewed in viewer. In viewer window in front of file name [Rev ] is displayed. 
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Chapter 3 

Known Issues 
This chapter includes the following: 

 Known Issue Disclaimer ...................................................................................................................................... 55 
 Installation ............................................................................................................................................................ 55 
 Common Services ............................................................................................................................................... 56 
 Product Collaboration .......................................................................................................................................... 59 
 Product Portfolio Management ............................................................................................................................ 62 
 Product Cost Management .................................................................................................................................. 63 
 Integration ............................................................................................................................................................ 66 
 Variant Management ........................................................................................................................................... 68 

This section contains a list of known issues for this release. These were deferred from this release, 
but may be fixed in a future release. Numbers in this section are for Oracle Agile internal use only. 

Known Issue Disclaimer 

This list of Known Issues consists of those found at the time of the initial release. The product may 
have additional issues found after the initial release and therefore this list is subject to change and 
is not always comprehensive. Oracle support will continue to track known issues of this product 
release found on My Oracle Support. Please check for updates at https://support.oracle.com. 

Installation 

9318047 

Database Installer 

Issue: This instruction is for customers upgrading from PLM "9.3-English" or "9.3.0.1-English" 
database to "9.3.0.1-NLS" database.  

Workaround: In the Agile PLM "9.3.0.1-NLS" release, Oracle delivers two Database Installers, 
namely, an English DB Installer and a Japanese DB Installer.  The Japanese DB installer is named 
agile9301db_jp_oracle10g11g installer.  

When PLM customer runs the Japanese DB Installer, and chooses the option to "Generate 
database scripts only", four scripts are generated and are delivered to a folder during Installation 
process. These are the steps: 

1. Customer runs agile9301db_jp_oracle10g11g for database installation, and chooses 
"Generate database scripts only" option during installation. 

2. After database installation is completed, customer can find scripts under the Agile9Tmp folder 
from installation process. 

3. On the same PLM instance where the DB was created, use ctxsys/ctxsys oracle user, run this 

https://support.oracle.com/
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script: agile9_fts_prefs.sql 

4. As a DB user, run these three scripts: agile9.sql, agile9_fts.sql, and 
agile9ctxstats.sql 

Expected results: Japanese FTS works fine. 

9054464 

Application Server 

Issue: User account lockout does not work on Windows WLS clustering environment. 

Workaround: This issue can be resolved by modifying the WebLogic setting. In a WebLogic server, 
log in to WLS console > Security Realms > AgileRealm > User Lockout tab. If both WLS and Agile 
Java Client user account lockout are enabled, but the setting on each side is different, then it will 
follow the WLS setting itself.  

1. Log in to Agile Java Client. 

2. Open Settings | User Settings | Account Policy. 

3. Set Account Lockout to Enabled and Logon Attempts to 3. 

4. Create a new user "test01", and assign password "agile". 

5. Log in to Web Client with test01/agile, the user can log in successfully. 

6. Log out and log back in with test01/aaa (that is, test by using incorrect password) three times. 

Each time the user gets the same message, "Invalid user or passowrd". 

On the fourth test, log in with as test01, note that the user can still log in, which reveals that the 
account has not been locked out.  

Now check the User Lockout setting in WLS console and notice that the logon attempts for the 
Weblogic server was set to 5. So the account is not locked out after failing to log on three 
times. 

 

Common Services 

8856122 

Folders, Files, and Attachments 

Issue: Thumbnail view doesn't work for certain Saved Searches. 

Steps to Reproduce: 

1. Log in to Web Client as a user having access for all saved searches. 

2. Go to Searches > Compliance Searches > Custom Parts without Composition in a Top-Level 
Assembly. 

3. Execute search with Part 1000-02. 
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4. In search result page, click Thumbnail View button. Thumbnail view does not work for this search 
result. 

Workaround: Select 'Thumbnail Only' option, search results are displayed with 'Thumbnail Only' view 
as expected. 

8932470 

Standard Report 

Issue: Chinese character is shown as "?" when exporting Report output to CSV/Excel formats. 

Steps to Reproduce:  

1. Log in to Web Client as an English user. 

2. Create a Part, give Chinese characters in the name. 

3. Run BOM Explosion Report with standard output format, select above part. 

4. Click Export after the report output is generated. 

5. Select CSV/Excel as Export Format, click OK. 

6. Open and save the file, check the report output. 

Actual Results: Chinese character is shown as '?' 

Expected Results: Chinese character should be shown well after exported to CSV/Excel format. 

Workaround: Export a report with Chinese characters after logging in as a Chinese user. 

9013935  

Folders, Files, and Attachments 

Issue: Purge Version is successful even though the same Version is used in Relationship of 
business objects.  

Steps to Reproduce: 

1. Create a Design object (DESIGN0001), add a file, and check in Version 1, then check out. 

2. Create a Design object (DESIGN0002), add files, and increment to version 3. 

3. Open DESIGN0001, select Structure tab, add DESIGN0002 by search. 

4. Check in DESIGN0001 [DESIGN0001 - Version 2]. 

5. Create a Part, select Relationships tab, add DESIGN0002 by search. 

6. Open DESIGN0001, select version 2 from version selector 

7. Select Purge Version from Actions menu and check the behavior, verify DESIGN0001, 
DESIGN0002 

8. DESIGN0001 Version 2 and DESIGN0002 Version 3 are purged. 



Readme  

 

 

58 Agile Product Lifecycle Management 

  

9. DESIGN0002 Version 3 is purged although attached to business object, in business object's 
Relationship tab, purging Version 2 is being updated. 

9108692 

Standard Reports 

Issue: BOM's Pending Rev should not be shown on BOM Explosion report output. 

Steps to Reproduce: 

1. Log in to Web Client. 

2. Create two Parts, p1and p2. 

3. Add p2 to p1's BOM. 

4. Create an ECO, add p1, p2 as Affected Items. 

5. Move to Pending status p1(A), p2(A), do not release the ECO. 

6. Run BOM Explosion Report on p1(A), check the report results. 

Actual Results: P2(A) also listed in the report output: 
 P1(A) 

   P2 (A) 

Expected Results: P2(A) should not be shown, P2's Rev should be Introductory: 
 P1(A) 

   P2(Introductory) 

Workaround: Add P1, P2 into different ECO. 

9109019  

Folders, Files, and Attachments 

Issue: "Get" is not working for unsupported HTML, HTM  file formats in the following scenarios. 

Steps to Reproduce: 

1. Not able to get the unsupported HTML and HTM file formats for view versions in all business 
objects using standard uploader. 

2. Not able to get the unsupported HTML and HTM file formats from the file folder and design object 
quick view using standard uploader. 

3. Not able to get the unsupported HTML and HTM file formats by clicking filename link from the file 
folder and design objects using standard uploader. 

4. Not able to get the unsupported HTML and HTM file formats when file is checked out in all 
business objects using standard uploader. 

Workaround: Use Get buttons from the tab menus of the object to get the HTML and HTM file 
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formats.  
 

Product Collaboration 

8883192 

Web Client / Product Collaboration 

Issue: Only record first "add related" object on Item > History tab. 

Steps to Reproduce: 

1. Log in to Web Client as admin. 

2. Create a part named P001. 

3. Go to Relationship tab, and add one existing object. 

4. Go to History tab, there is one record "Action: Add Related Object". 

5. Back to Relationship tab, and add some other objects. 

6. Back to History tab, there is still one record "Action: Add Related Object". This does not record 
second added objects information. 

Note1: Even if you click refresh button, it still doesn't get the latest info. If you log out and login 
again, it still doesn't get the latest info. 

Note2: This issue only occurs in Items (Parts or Documents). 

Workaround: You can log in to Java Client, search this part, and click Refresh button, then log in to 
Web Client, get the updated records on History tab. 

9009698 

Java Client / Product Collaboration 

Issue: The expected error message does not appear when Java Client user does not have sufficient 
privilege. 

Steps to Reproduce: 

1. Log in to Java Client as admin. 

2. Create a user named userA without Read or Discover privileges to Documents (but can have 
Read and Discovery privileges to Parts). 

3. Create  part01, part 02, doc01, and add doc01 and part02 to BOM of Part01. 

4. Log in again to Java Client by userA. 

5. Search Part01, go to BOM tab. Find that: there is only part02 display there, the expected error 
message (e.g., "There is 1 row missing due to insufficient user Privileges") is missing. 

Workaround: None Available 
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9010109 

Java Client / Product Collaboration 

Issue: Broken in adding BOM when user without that site is associated on Java Client. 

Steps to Reproduce: 

1. Log in to Java Client as admin. 

2. Create a site named site01, and enable it. 

3. Create a user named userA, make sure that userA does not have that site01. 

4. Create a part01, and add site01. 

5. Log in again to Java Client by userA. 

6. Create two part02, part03. 

7. Go to BOM tab of part02, search part03 and part01 to add.Error dialog prompt that "Cannot open 
Item part01 because the user does not have a site that the item is associated with", then click OK. 
Find that: there is no part added, when the expected result is that Part03 should be added 
successfully. 

Workaround: You can add BOM on Web Client first, then the BOM information is reflected on Java 
Client. 

9035132 

Changes 

Issue: Item number display one space on BOM bulk change end windows. 

Steps to Reproduce: 

Precondition: Make sure Item.Number ::'Include Characters' field  as "All". 

1. Log in to Web Client. 

2. Create several parts with number containing multiple space. 

3. Create a ECO against one part, go to AI tab. 

4. Do BOM BULK Change as following: 

5a. Add an item to multiple assemblies 

5b. Replace an item on multiple assemblies 

5c. Remove an item from multiple assemblies 

5d. Find assemblies related to an item and add them as affected items. Notice that Item Number 
displays only one space instead of actual whitespace on the last BOM bulk change windows. 

Workaround: None Available 
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9131656 (also see 8890982 in Resolved Issues: Product Collaboration) 

Web Client / Product Collaboration 

Issue: Display extra space in edit mode for Reference Designator attribute ("Ref Des"). 

Steps to Reproduce: 

1. Log in to Java Client as admin. 

2. Go to Classes > Items > Parts > User-Interface Tabs > BOM > Attributes: BOM tab > Ref Des > 
click and use New Character Set. 

Valid Characters Set = 1234567890ABCDEFGHIJKLMNOPQRSTUVWXYZp:_-, 

4. Log in to Web Client. 

5. Create two parts P001, P002, and add P002 as BOM of P001. 

6. Go to BOM tab, modify the Ref Des - using upper case with comma (e.g: AB,CD), Actual result: 
Hit "enter" key or move mouse, extra space along with comma display there in edit mode. Expected 
result: "AB,CD" should display there. Similar issue occurs in redline BOM. 

Note: after saving it, "AB,CD" correctly displays there. 

Workaround: None Available 

9140948 

Web Client / Product Collaboration 

Issue: The mass fields are not showing with redline when using placeholder BOM. 

Steps to Reproduce: 

Precondition: in Admin, enable Item.BOM.Mass field 

1. Create Part1 and Part2. 

2. Edit Part2's Mass fields with a value. 

3. Add Part2 to Part1's BOM. 

4. Create ECO1 against Part1. 

5. Redline edit Part2 with a placeholder such as "xxx".  Notice the values of Part2's Mass is not 
showing with a redline. 

Workaround: None Available 

9172903 

Web Client / Product Collaboration 

Issue: Reference Designator attribute ("Ref Des"): old value does not display in bottom row before 
saving. 
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Steps to Reproduce: Precondition: Make sure that Admin Preference (in Java Client) "Reference 
Designators Allow Range Expand Collapse" is set to Collapse. 

1. Log in to Web Client. 

2. Create two parts, named P001, P002. Add P002 as BOM of P001, modify Qty = 100, and Ref 
Des = A1–100. 

3. Create a change C001 against P001, go to Redline BOM tab. 

4. As for P002, redline Ref Des from A1–A100 to Q1–Q30. Actual result: only one row displays. 
Expected result: The old value should also display in the bottom row with a red strikethrough. 

Workaround: None Available 
 

Product Portfolio Management 

9048768 

Content Management 

Issue: Not able to filter data according to mandatory attribute in content tab. 

Steps to Reproduce:  

1. In Web Client, create a Program and navigate to Content tab. 

2. Click Add and add a few contents. 

3. Open Personalize Palette and navigate to Filter tab. 

4. Select Mandatory field in Filter list. 

Note: Mandatory attribute is not displayed. 

Workaround: 

1. Open Personalize Palette from Content tab and navigate to Format tab. 

2. Hide the Mandatory field. 

3. Now navigate to Filter tab of Personalize Palette and filter according to Mandatory attribute. 

9049232 

Content Management 

Issue: User is not able to filter according to related to field in content tab. 

Steps to Reproduce:  

1. In Web Client, create a Program with Task and Subtasks. 

2. Navigate to Content tab of each Task and Subtask and add few contents. 
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3. Now navigate to Content tab of root Program and check Display All Levels checkbox. 

4. Open Personalize Palette and navigate to Filter tab. 

5. Filter according to Related field as Related To contains Task Name and check the data 
displayed. 

Note: Data is not displayed for any filter applied based on Related To field. 

9049348 

Gantt Chart 

Issue: Assigned from is not editable in Gantt task assignment view if we select two gates. 

Steps to Reproduce:  

1. In Web Client, create a Program with one Task and two Gates. 

2. Launch Gantt Chart for root Program. 

3. Invoke Task Assignments view. 

4. Select all the rows and add a few Resources from a Resource Pool. 

5. Update the changes.  

6. Now select two Gates and try to edit Assigned From field displayed in Task Assignment view. 

Note: Not able to edit the Assigned From field. 

Workaround: Select one Gate row at a time and edit the Assigned From field. 
 

Product Cost Management 

8199842 

Web Client / Product Cost Management 

Issue: The "Consider Historical Quotes Occur Within" option should be part of breaking ties. 

Workaround: None Available 

8915180 

Web Client / Product Cost Management 

Issue: The response lines are being created for all the AMLs instead of the filtered AMLs using RFQ. 

Steps to Reproduce: 

1. Create an Item P1 with 2 AMLs with AML Status 

AML1 --> Alternate 

AML2 --> Preferred 
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2. Create a Sourcing Project and add the above Item with AMLs. 

3. Go to AML and apply the Filter as Cost In (Yes) and AML Status In (Alternate). 

4. Save the filter. 

5. Display AMLs and check the Mfr. Parts. (It should display only AML1). 

6. Select the Item with AML1 and click Create from Quote Menu. 

7. Create the RFQ and go to Response tab. 

8. Check the Response lines in Response tab. The Response lines are created for both the AMLs 
instead of AML1 only. 

Workaround: None Available 

9039427 

Price / PCO 

Issue: The user receives a fatal error message when the custom flex-fields from Page Three are 
"Mandatory" while importing a Price object. 

Steps to Reproduce: 

1. Log in to Java Client. 

2. Open Prices > Page Three and create custom flex-fields CText01 and CNumeric01, setting them 
to As Required. 

3. Log in to Web Client. 

4. Create a Part, and then create an Import file for the Part. 

5. Make sure to have blank values for the two flex-fields. 

6. Click Import. 

7. Select the file and do mapping (make sure to map all the flex-fields). 

8. Click Import and the system throws an error saying, "Fatal Exception occurred. Node (10321, 
2623268) does not exist in the cache."  and ends the Import process. 

Workaround: None Available 

9040032 

Sourcing Project 

Issue: The user receives a fatal error in the Item tab, when the BOM Filter is applied for BOMText 
like (%text%) and Not like. 

Steps to Reproduce: 

1. Log in to Java Client and enable BOM Text in Item from the BOM tab. 
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2. Open Sourcing Project Item tab and enable Filter. Enable the filter in AML tab also. 

3. Log in to Web Client. 

4. Create a Part P1 and add BOMs so it is a subassembly: 

P1 

BOM1--BOMText01--text 

BOM2--BOMText02--sample 

5. Create a Sourcing Project and add this subassembly to it. 

6. Apply BOM Filter: BOM Text01 Like "%text%" and see that it shows a fatal error in the Item tab. 

Workaround: None Available 

9080193 

Sourcing Project 

Issue: The user is unable to publish a Price for the Item released with a different LifeCycle Phase. 

Steps to Reproduce: 

1. Create an Item. 

2. Create an ECO and change the LifeCycle Phase of the Item from Preliminary to another 
LifeCycle Phase (e.g., Pilot, Prototype). 

3. Release the ECO. 

4. Create a Sourcing Project and add the Item with a Revision. 

5. Create an RFQ and open it to Suppliers. 

6. Get a Response from a Supplier. 

7. Go to Analysis tab; publish the Price to Item Master. An error is thrown, and a ToolTip of the error 
icon shows "Java.util.Arraylist". 

Workaround: None Available 

9187013 

Sourcing Project 

Issue: The user is unable to get the file attachment of Items/MPNs on Supplier side. 

Steps to Reproduce: 

1. Create an Item with AMLs and add attachments for Item and MPNs. 

2. Create a Sourcing Project and add the above item. 

3. Create an RFQ and open it to Suppliers. 
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4. Log in as the Supplier and open the RFQ from the Response tab. 

5. Click the Quick View of the Item/MPN and go to the Attachment tab where the user can only view 
the attachment because the "Get" option is unavailable. 

Workaround: None Available 

9204775 

Sourcing Project 

Issue: Supply Base Analysis report is not working from Sourcing Project > Analysis tab (only). 

Steps to Reproduce: 

1. Create Sourcing Project and add assembly. 

2. Create RFQ and get response from suppliers. 

3. Go to Analysis tab. 

4. Do set as best and run cost rollup. 

5. Run the Supply Base Analysis report. 

Comment: It doesn't display any data. But it works fine from Left Pane Reports folder. 

Workaround: The user can execute the Supply Base Analysis report from the Reports and Analytics 
> Sourcing Reports > Supply Base Analysis Report. 
 

Integration 

Import 

8945902 

Import 

Issue: Not able to import the exported site-specific BOM specific to AXML. 

Steps to reproduce: 

1. Log in to Web Client. 

2. Create a BOM structure as below: 
 Level, Number, PartType, Description, Sites, BOM.Qty, BOM.FindNum, BOM.Sites 
 0, AP01, Document, , Hong Kong; India,,, 
 1, AP02, Document, , Hong Kong, 1, 0, Hong Kong 
 2, AP03, Part, , Hong Kong, 1, 0, Hong Kong 
 1, AP02, Document, , India, 1, 0, India 
 2, AP03, Part, , Hong Kong, 1, 0, Hong Kong 
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3. Export the BOM in AXML and try to re-import. 

Note: Error related to duplicate BOM occurs and the whole BOM was rejected. 

4. Now export the same BOM in PDX or Excel -level template and try to re-import. Import will be 
successful 

Agile Technology Platform 

9014719 

Directory Access Protocol (LDAP) 

Issue: User/User group Page Two Multitext attribute value is not updated for ldap users from ldap 
directory after syncup if multitext attribute has default value in Agile DB. 

Steps to Reproduce: 

1. Log in to Java Client, 

2. Enable Page two MultiText attribute for both User and User Group objects and set some default 
value. 

3. In LDAP configuration, map the Agile MultiText attributes of Users and User Groups to LDAP 
attributes that have some values. 

4. Synchronize Agile with LDAP. 

5. Open the migrated LDAP User/User Group and navigate to Page Two. 

6. Check the values displaying for MultiText attribute. 

Actual Result:  It displays the default value set in Agile for MultiText attribute. 

Expected Result:  It should display the value migrated from LDAP for that User/User Ggroup 
MultiText attribute. 

Workaround: None available. 

9199863 

Engineering Collaboration (EC) BPEL Services 

Issue: EC BPEL Services, which invokes getTableMetaData core services, are failing for Japanese 
user. 

Steps to Reproduce: 

1. Log in to Java Client. 

2. Create user and set Japanese language for user. 

3. Deploy BPEL Processes with Japanese user credentials. 

4. Below 3 BPEL SERVICES are failing at InvokeGetTableMetaData call. 
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1. GetDesignPropertiesAndRights 

2. GetDesignItemPropertiesAndRights 

3. RetrieveDesignStructureAndMetatdata 

Expected Result: It should not fail at getTableMetaData call. 

WorkAround: None available 
 

Variant Management 

9268019 

Instance Manager 

Issue: Error shows when updating the Model BOM in the background. 

Workaround: No workaround solution is available. 

Administration 

12775046 

Administration: Users/User Administration 

Issue:  EDITING ESCALATIONS IS NOT AVAILABLE IN 9.3.x 

Steps to Reproduce:  1. Log in to Administrator. 

  2. Search and open a User. 

  3. Click Escalation tab. 

  4. Add a User. 

  5. Should be able to edit the user you just added. 

Workaround:  You have to delete and re-create an Escalation assignment in order to modify the 
assigned escalation.   

___ 

 


